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Preface


This document is a formal contract deliverable with an approval code 1. It requires Government

review and approval prior to acceptance and use. This document is under ECS contractor

configuration control. Once this document is approved, Contractor approved changes are handled

in accordance with Class I and Class II change control requirements described in the EOS

Configuration Management Plan, and changes to this document shall be made by document change

notice (DCN) or by complete revision.


This document is under the control of the EDF Configuration Control Board (CCB).


Any questions should be addressed to:


Data Management Office

The ECS Project Office

Raytheon Systems Company

1616 McCormick Dr.

Upper Marlboro, MD 20774-5301
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Abstract


This document describes the human-machine interface (HMI) characteristics of the tools (computer 
software configuration items) used by the ECS operations staff. 

Keywords:  Computer Software Configuration Items (CSCIs), GUI, Interface, Operations, 
Release 4, Screens, Software, Tools 
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1. Introduction 

1.1 Identification 

The Release 4 Operations Tools Manual, Contract Data Requirements List (CDRL) item 116, 
whose requirements are specified in the revised Data Item Description (DID) 609/OP1, is a 
required deliverable under contract NAS5-60000. 

1.2 Purpose 

This document describes the human-machine interface (HMI) characteristics of the tools 
(configuration items) that will be used by the ECS operations staff when performing the following: 

• computer systems administration 

• system monitoring 

• configuration management 

• security and accountability 

• science software integration and testing 

• resource planning 

• production planning and processing 

• science data ingest, archive and distribution 

• user services 

• common services 

This document provides background information that is the basis for the Release 4 Operations 
Procedures for the ECS Project (DID 611/OP3). The 609 document is intended to (1) familiarize 
the ECS operators with their tools, (2) be used as a reference for all ECS operational tasks, and (3) 
be used as an aid during training of ECS operations staff. 

1.3 Scope 

This document applies to Release 4, and not to any subsequent releases of the ECS. This document 
is limited to (1) a detailed description of customized operator tools, (2) a brief description of COTS 
software used by operations and references to the applicable vendor manuals, and (3) a detailed 
description of customized Commercial Off-the-Shelf (COTS) software. This document will point 
to DID 611 for all operational procedures or to individual COTS manuals for detailed COTS 
instructions. It is intended for use by operators and maintainers of the ECS system during the 
period in which Release 4 is used. 
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1.4 Status and Schedule 

This submittal of DID 609/OP1 meets the milestone specified in the Contract Data Requirements 
List (CDRL) of NASA contract NAS5-60000. 

This document reflects the February 14, 1996 Technical Baseline (210-TP-001-006) submitted via 
contract correspondence No. ECS 194-00343. 

1.5 Organization 

This document is organized to describe the tools used by ECS operations staff during Release 4. 

Section 1.0 provides information regarding the identification, scope, purpose, status, and 
organization of this document. 

Section 2.0 provides a listing of related documents, which were used as source information for this 
document. The section also identifies the documentation provided for each Release 4 software 
component. 

Section 3.0 provides a brief overview of the Release 4 ECS. 

Section 4.0 This section provides a detailed description of Release 4 operations tools. It is 
organized by operation function and provides the following types of information: tools overview, 
required operating environment, CSCI function, operator commands, system messages, reports, 
and outputs. 

Appendix A provides a description of Release 4 system status and error messages, including 
probable causes, impacts, and proposed actions. 

The Abbreviations and Acronyms section contains an alphabetical list of the abbreviations and 
acronyms used in Release 4. 

The Glossary section contains terms used in this document. 
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2. Related Documentation 

2.1 Parent Documents 

The parent document is the document from which the scope and content of this Release 4 
Operations Tools Manual has been derived. 

423-41-02	 Goddard Space Flight Center, Functional and Performance 
Requirements Specification for the Earth Observing System Data and 
Information System (EOSDIS) Core System (ECS) 

423-41-03 EOSDIS Core System Contract Data Requirements Document 

2.2 Applicable Documents 

The following documents are referenced within this Release 4 Operations Tools Manual, are 
directly applicable, or contain policies or other directive matters that are binding upon the content of 
this volume. 

102-CD-002	 Maintenance and Operations Configuration Management Plan for the 
ECS Project 

205-CD-002	 Science User's Guide and Operations Procedure Handbook, Volume 4: 
Software Developer's Guide to Preparation, Delivery, Integration and 
Test with ECS 

205-CD-004	 Science User's Guide and Operations Procedures Handbook (Release 
B.0) for the ECS Project 

194-207-SE1 System Design Specification for the ECS Project 

304-CD-003	 Communications and System Management Segment (CSMS) 
Requirements Specification for the ECS Project 

305-CD-100 Segment/Design Specification for the ECS Project 

307-CD-002	 Science Data Processing Segment Release and Development Plan for the 
ECS Project 

311-CD-101	 Data Distribution Database Design and Schema Specifications for the 
ECS Project (Draft) 

311-CD-102	 Data Management Database Design and Schema Specifications for the 
ECS Project (Draft) 

311-CD-104	 Interoperability Subsystem (IOS) Database Design and Schema 
Specifications for the ECS Project (Draft) 
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311-CD-105	 Management Support Subsystem Database Design and Schema 
Specifications for the ECS Project (Draft) 

311-CD-106	 Planning and Data Processing Subsystem Database Design and Database 
Schema Specifications for the ECS Project (Draft) 

311-CD-107	 Science Data Server Database Design and Schema Specifications for the 
ECS Project (Draft) 

311-CD-108	 Storage Management Database Design and Schema Specifications for 
the ECS Project (Draft) 

311-CD-109	 Subscription Server Database Design and Schema Specifications for the 
ECS Project (Draft) 

601-CD-001 Maintenance and Operations Management Plan for the ECS Project 

604-CD-002 ECS Operations Concept for the ECS Project: Part 2B - ECS Release B 

605-CD-002 Release-B SDPS/CSMS Operations Scenarios for the ECS Project 

609-CD-001	 Interim Release One (Ir1) Maintenance and Operator's Procedures for 
the ECS Project 

611-CD-004	 Mission Operation Procedures - Ver. 2, Rel. 2.0, Drop 4.0 for the ECS 
Project 

613-CD-003 Release B COTS Maintenance Plan for the ECS Project 

625-CD-001 ECS Project Training Material Volume 1: Course Outline 

625-CD-002	 ECS Project Training Material Volume 2: Introduction and System 
Overview 

625-CD-003 ECS Project Training Material Volume 3: Problem Management 

625-CD-004 ECS Project Training Material Volume 4: System Administration 

625-CD-005 ECS Training Material Volume 5: Network Administration 

625-CD-006	 ECS Project Training Material Volume 6: Production Planning and 
Processing 

625-CD-007 ECS Project Training Material Volume 7: Resource Planning 

625-CD-008 ECS Project Training Material Volume 8: Ingest 

420-TP-007 Planning Workbench Detailed Design for the ECS Project 

625-CD-009	 ECS Project Training Material Volume 9: Data Distribution 

ECS Project Training Material Volume 10: Archive Processing625-CD-010 
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625-CD-011 ECS Project Training Material Volume 11: Database Administration 

625-CD-012 ECS Project Training Material Volume 12: Configuration Management 

625-CD-013 ECS Project Training Material Volume 13: User Services 

625-CD-016	 ECS Project Training Material Volume 16: Science Software Integration 
and Test 

625-CD-017 ECS Training Material Volume 17: System Troubleshooting 

IMSV0-OP-GD-001	 EOSDIS Information Management System, Users Manual for Release 
6.0 of the V0 IMS (April 1996), Hughes STX Corp., Upper Marlboro, 
MD 

IMSV0-PD-SD-002	 EOSDIS Information Management System, Messages and Development 
Data Dictionary, V0 and Release A Message Passing Protocol (1995), 
Hughes STX Corp. Upper Marlboro, MD 

2.3 Information Documents 

The following documents are referenced herein, and amplify or clarify the information presented in 
this document. These documents are not binding on the content of the Release 4 Operations Tools 
Manual. 

Action Request System 2.0, Troubleshooting and Error Messages Guide (1995), Remedy 
Corporation, Mountain View, CA 

Action Request System 2.0, User’s Guide for OSF/Motif (1995), Remedy Corporation, Mountain 
View, CA 

AIX Version 4.1 iFOR/LS System Management Guide First Edition (1994), Gradient Technology 
Inc, 11400 Burnet Rd., Austin Tx 78758-3493 

AIX Version 4.1 iFOR/LS Tips and Techniques First Edition (1994), Gradient Technology Inc, 
11400 Burnet Rd., Austin Tx 78758-3493 

AMASS Overview Version 4.9(1997), EMASS Inc, 10949 East Peakview Ave., Englewood, CO 
80111 

AutoSys User Manual, Version 3.2, August 1995, AutoSystems Development Lab, PLATINUM 
Technology, Inc., Boulder, CO 

AutoXpert User Guide, Unix BETA Version 1.0, July 1995, AutoSystems Development Lab, 
PLATINUM Technology, Inc., Boulder, CO 

C Language Reference Manual (1995), Silicon Graphics, Inc., Mountain View, CA 

ProDev Workshop Environment Guide (1994), Silicon Graphics, Inc., Mountain View, CA 
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ProDev Workshop User’s Guide Volume I:  The Debugger, Build Manager, and Static Analyzer 
(1994), Silicon Graphics, Inc., Mountain View, CA 

ProDev Workshop WorkShop User’s Guide Volume II: The Performance Analyzer and Tester 
(1994), Silicon Graphics, Inc., Mountain View, CA 

ClearCase Administrator’s Manual, Unix Edition Release 2.0 and later (1995), 4000-013-B, Atria 
Software Inc., Natick, MA 

ClearCase Quick Reference Manual, Unix Edition Release 2.0 and later (1995), 4000-013-B, Atria 
Software Inc., Natick, MA 

ClearCase User’s Manual, Unix Edition Release 2.0.2 and later (1995), 4000-011-B, Atria 
Software Inc., Natick, MA 

DCE Cell Manager 1.6.2 Overview and User’s Guide (1997), Chisholm Technologies Inc, 6805 
Capital of Texas Hwy, Austin Tx 78731 

Displaying Information and Generating Reports (iFOR/LS) (1994), Gradient Technology Inc, 
11400 Burnet Rd., Austin Tx 78758-3493 

Errors and Corrective Action (AMASS) Version 4.9 (1997), EMASS Inc, 10949 East Peakview 
Ave., Englewood, CO 80111 

Enterprise SQL Server Manager User’s Guide, Release 10.0.2 (1995), Sybase, Inc. Emeryville, 
CA 

Expert Analyzer Output File Format (1995), Network General Corporation, Menlo Park, CA 

Expert Sniffer Network Analyzer Operations (1995), Network General Corporation, Menlo Park, 
CA 

FDDI Overview and Guide to Troubleshooting (1995), Network General Corporation, Menlo 
Park, CA 

Fortran 77, Language Reference Manual (1991), Silicon Graphics, Inc., Mountain View, CA 

HP OpenView Using Network Node Manager, 1995, 3404 E. Harmony Rd., Ft. Collins CO 
80525 

HP OpenView, Network Node Manager Products, Installation Guide, 1995, 3404 E. Harmony 
Rd., Ft. Collins CO 80525 

IDL Reference Guide, Interactive Data Language (1991), Volumes 1 and 2, Version 4.0, Research 
Systems, Inc., Boulder CO 
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IDL User’s Guide, Interactive Data Language (1995), Version 4.0, Research Systems, Inc., 
Boulder CO 

iFOR/LS Administrator’s Guide (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx 
78758-3493 

iFOR/LS Installation Notes (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx 
78758-3493 

iFOR/LS Quick Start Guide (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx 
78758-3493 

iFOR/LS Quick Start Guide, Hewlett-Packard Version (1994), Gradient Technology Inc, 11400 
Burnet Rd., Austin Tx 78758-3493 

Illustra Installation and System Administration Guide (1995), Illustra Server Rel. 3.2, Illustra 
Information Technologies, Inc., Oakland, CA 

Illustra User’s Guide (1995), Illustra Server Rel. 3.2, Illustra Information Technologies, Inc., 
Oakland, CA 

Intelligent Query and IQ Access User’s Guide for Windows and Motif, Version 5 (1996), IQ 
Software Corporation, Norcross, Georgia 

Introduction to SPARCworks, SunPro (1992), Sun Microsystems, Inc. Mountain View, CA 

Installing and Configuring Amass Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave., 
Englewood, CO 80111 

IQ Installation Guide for Unix Motif (1995), IQ Software Corporation, Norcross, Georgia 

IQ System Manager’s Guide, Versions 3, 4, & 5 (1995), IQ Software Corporation, Norcross, 
Georgia 

IRIX Networker Administrator’s Guide, Silicon Graphics Computer Systems (1995), 007-1458
030, Mountain View, CA 

IRIX Networker User’s Guide, Silicon Graphics Computer Systems (1995), 007-1458-030, 
Mountain View, CA 

Managing the AMASS File System Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave., 
Englewood, CO 80111 

Microsoft Excel User’s Guide, Version 5 (1993-94), Microsoft Corporation 

Microsoft PowerPoint User’s Guide, Version 4.0 (1994), Microsoft Corporation 
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Microsoft Word, Version 6.0 (1993-94), Microsoft Corporation 

MIPSpro Fortran 77 Language Reference Manual (1994), Silicon Graphics, Inc. Mountain View, 
CA 

Netscape Navigator Handbook (Version 3.0), S. Kronick, Netscape Communications 
Corporation, Mountain View, CA 

NetWorker Administrator’s Guide (1996), Legatto Systems, Inc., 3145 Porter Dr., Palo Alto CA 
94304 

NetWorker User’s Guide (1996), Legatto Systems, Inc., 3145 Porter Dr., Palo Alto CA 94304 

Network/Communications Management, Volume 1, MT923 Physical Network Management 
(1995), Accugraph Corporation, El Paso, TX 

Open Client DB-Library/C Reference Manual (1993)  , Sybase Inc., 6475 Christie Avenue, 
Emeryville, CA 94608 

Open Client and Open Server Common Libraries Reference Manual (1993), Sybase 
Inc., 6475 Christie Avenue, Emeryville, CA 94608 

PureDDTS Administrator's Manual, version 3.2, Pure Software Inc., Sunnyvale, CA 

PureDDTS Manual Pages Reference Guide, version 3.2, Pure Software Inc., Sunnyvale, CA 

PureDDTS User's Manual, version 3.2, Pure Software Inc., Sunnyvale, CA 

Replication Server Administration Guide (1995), Sybase, Inc., Emeryville, CA 

Replication Server Commands Reference (1995), Sybase, Inc., Emeryville, CA 

Replication Server Installation Guide (1995), Sybase, Inc., Emeryville, CA 

Replication Server Troubleshooting Guide (1995), Sybase, Inc., Emeryville, CA 

Sniffer Network Analyzer: Ethernet Monitor Operations (1995), Network General Corporation, 
Menlo Park, CA 

Sniffer Network Analyzer: FDDI Monitor Operations (1995), Network General Corporation, 
Menlo Park, CA 

SQL Server Error Message, (1995), Sybase, Inc., Emeryville, CA 

SQL Server Troubleshooting Guide, (1994), Sybase, Inc., Emeryville, CA 

SQL Server Utility Programs for UNIX, (1994), Sybase, Inc., Emeryville, CA 
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SQR3 Workbench, SQR User’s Guide (1995), version 3, MITI, Long Beach CA


The SQL Server Installation Guide, (1994), Sybase, Inc., Emeryville, CA


StdRef Chapter 12: Object Description Language (ODL) Specification and Usage,

http://pds.jpl.nasa.gov/stdref/chap12.htm 

SYBASE SQL Server Error Messages, Releases 4.2-10.0.2, (1995), Sybase, Inc., Emeryville, 
CA 

SYBASE SQL Server System Administration Guide (1994), Sybase, Inc, Emeryville, CA 

SYBASE SQL Server Troubleshooting Guide (1994), Sybase, Inc, Emeryville, CA 

Sybase SQL Server Reference Manual Vol. 1 and Vol. , (1994), Sybase, Inc., Emeryville, CA 

System Administration Guide for SQL Server (1994), Sybase, Inc, Emeryville, CA 

System Administration Guide Supplement (operating-system specific system administration tasks) 
(1994), Sybase, Inc, Emeryville, CA 

Tivoli/ Enterprise Console Event Adapter Guide, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli Enterprise Console User’s Guide, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli Host Management Guide, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli Management Platform User’s Guide (Release 2.5) , (1995), Tivoli Systems Inc., Austin, 
TX 

Tivoli/Sentry Monitoring Collection Reference Manuals, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli/Sentry User’s Guide, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli User and Group Management Guide, (1995), Tivoli Systems Inc., Austin, TX 

UNIFY Developer's Reference (1989), UNIFY Corporation, Sacramento, CA 

UNIFY Direct HLI Programmer's Manual (1989), UNIFY Corporation, Sacramento, CA 

UNIX in a Nutshell, A Desktop Quick Reference, System V Edition (1994). Gilly, D. and staff of 
O'Reilly & Associates, Inc., O'Reilly & Associates, Inc., Sebastopol, CA 

Using the AMASS GUI Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave., 
Englewood, CO 80111 

XRP-II Datalook/Datarite Reference Manual (1995), HTG, Ft. Worth TX 
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XRP-II Product Information Manual (1995), HTG, Ft. Worth TX 

XRP-II System Reference Manual (1995), HTG, Ft. Worth TX 

XRP-II Tools, Techniques, and Conventions Manual (1995), HTG, Ft. Worth TX 

VolServ Graphical User Interface Guide (1995), VolServ, version 2.3, EMASS, Englewood, CO 

Wabi User’s Guide (1993), Sun Microsystems, Inc., Mountain View, CA 

Z-Mail for Motif Installation Guide, Version 3.2 (1994), Z-Code Software/NCD Software 
Corporation, Novato, CA 

Z-Mail for Motif Reference Manual, Version 3.2 (1994), Z-Code Software/NCD Software 
Corporation, Novato, CA 

Z-Mail for Motif User’s Guide, Version 3.2 (1994), Z-Code Software/NCD Software 
Corporation, Novato, CA 

Z-Mail Network License Server Installation and Maintenance Guide (1994), Version 1.8, Z-Code 
Software/NCE Corporation, Novato, CA 
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3. Release 4 Overview 

3.1 Release 4 Objectives 

3.1.1 ECS Mission Support Baseline 

The Release 4 ECS system supports the Landsat-7, AM-1, and Meteor SAGE III missions, as 
shown in Table 3.1.1-1 below. Release 4 also supports the Data Assimilation Office (DAO) at the 
GSFC DAAC. 

Release 4 is designed to assure successful transition to support future releases. Subsequent 
releases will support future EOS missions, such as EOS PM-1, and will incorporate evolutionary 
changes such as new processing and storage technologies, new distributed computing 
infrastructure, and expanded data metaphors and services. Successive releases will provide 
expanded and increasingly enhanced data search and access, based on feedback from the science 
community. 

Table 3.1.1-1. Mission Baseline 
Missions Instruments Launch Date 

Landsat-7 ETM+ March 1999 

EOS AM-1 ASTER, CERES, MISR, MODIS, 
MOPITT 

July 1999 

Meteor SAGE III July 1999 

3.1.2 Release 4 Capabilities 

The Earth Observing System (EOS) Data and Information System (EOSDIS) Core System (ECS) 
capabilities are developed in terms of formal releases. Release 4, the initial formal release beyond 
the test bed, provides capabilities that are designed to support the Landsat-7, AM-1, and Meteor 
SAGE III missions. 

Release 4 is deployed at four locations (SMC, and DAACs at GSFC, EDC and LaRC). 

A more detailed overview of the Release 4 ECS may be found in the Release 4 Segment/Design 
Specifications for the ECS Project, 305-CD-100-005. 
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4. Description of the ECS Operational Tools 

The human-machine interface (HMI) characteristics description of the software tools that the ECS 
operator uses to perform routine ECS operations is listed by the following major functional areas: 

4. Computer Systems Administration


4. System Monitoring (Problem, Fault, and Performance Management)


4. Configuration Management


4. Security and Accountability


4. Science Software Integration and Testing


4. ECS Data Ingest


4. Resource Planning


4. Production Planning


4. Production Processing


4.10 Science Data Archive and Distribution


4.11 User Services


4.12 Common Services


When using this document, the reader should note the following:


•	 The screens/GUIs presented in this section are samples and often do not reflect the actual 
window contents seen by the DAAC operator because they depend on hardware 
configuration, actual server names, directories, etc. 

•	 Basic Unix, Network and application configuration and utilities are not explicitly addressed 
in this document. 

•	 Except for those programs that are not Motif programs and require an ASCII interface, 
launching tools from the command line is avoided as much as possible to give operations 
management the ability to control (a) access to the Unix command line and shell; and (b) 
reduce the use of the xterm. 

•	 Release 4 directory structure is discussed in DID 612, which is the Programmer's Manual 
for each of the Release 4 DAACs and the SMC. 

•	 This document references the ECS Baseline Information System web page, URL 
http://cmdm.east.hitc.com/, in several places for information on the Required Operating 
Environment. This web page is currently being constructed for the desired information in 
the ECS Baseline. Until it is put in place, the reader is referred to the DAAC library for 
hard copies. 
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4.1 Computer Systems Administration 

This section describes the computer system administration tools used by DAAC operators: 

• Legatto’s Networker 

• DBVision 

• AMASS 

• ISQL 

• SQR Report Writer 

• Intelligent Query and IQ Access 

• Sybase Replication Server 

• Global Change Master Directory (GCMD) 

• MIB Browser 

• Mode Manager 

• ECSAssist 
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4.1.1 Legatto NetWorker 

Legatto’s NetWorker is a set of three components -Administration, Backup, and Recovery - used 
by system administrators to back up the entire system, with the exception of DBMS files (see 
Section 4.1.5, “ISQL”, for details on backup of DBMS files). The basic configuration is to have a 
NetWorker Server with a backup device (i.e., Jukeboxes or 8mm tapes) networked to a number 
of clients which represent the subsystem hosts. 

Site-wide system backup is performed by NetWorker. It provides a suite of integrated tools for 
backup and recovery, archive and retrieval, and hierarchical storage management. The product 
supports multi-platform networks, contains a motif-based GUI with on-line help, and supports 
concurrent device support for parallel backup and recovery using up to 16 storage devices. Both 
scheduled and ad-hoc backups, recoveries and other data management services can be performed 
by authorized users. NetWorker software consists of two components: a client portion, which runs 
on the systems to be backed up, and a server portion, which is the system to which the backup 
devices are connected. The client portion sends the data to be backed up to the server portion which 
then writes the data out to disk. 

NetWorker is used to perform the operator functions listed in Table 4.1.1-1. 

Table 4.1.1-1. Common ECS Operator Functions Performed with 
NetWorker 

Operating 
Function 

GUI Description When and Why to Use 

manage, configure, 
and monitor 
NetWorker 

• NetWorker 
Administrator 
GUI 

allows monitoring of server 
status, devices, sessions, 
messages, and pending 
displays 

to start NetWorker tasks and 
monitor server activity 

monitor and 
schedule backup 

• NW Backup 
GUI 

• group backup 
• scheduled backup 
• incremental backup 

to back up client files 

recovering backed 
up files 

• NW Recover 
GUI 

retrieves files that have been 
backed up 

to recover backed up client 
files 

4.1.1.1 Quick Start Using NetWorker 

This section presents an orientation of NetWorker. For more information, see the NetWorker 
User’s Guide, and the NetWorker Administrator’s Guide, Using NetWorker Windows and 
Menus. 

The documentation used is for version 4.2.5 of NetWorker. 
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4.1.1.1.1 Invoking NetWorker From the Command Line Interface 

The NetWorker Admistrator tool is used to manage and configure the NetWorker environment. To 
execute NetWorker Administrator from the command line prompt use: 

nwadmin <-s server_name> & 

The NetWorker Backup tool is used to backup files on client machines. To execute NetWorker 
Backup from the command line prompt use: 

nwbackup <-s server_name> & 

The NetWorker Recover tool is used to recover files on client machines. To execute NetWorker 
Recover from the command line prompt use: 

nwrecover <-s server_name> & 

Note: The optional -s server_name is used only in NetWorker environments that have multiple 
NetWorker servers. 

4.1.1.1.2 Invoking NetWorker From the ECS Desk top. 

To invoke the NetWorker Administrator program, click on the NetWorker Administrator icon 
below. Note that the title of this icon is the NetWorker server name. 

Figure 4.1.1-1. NetWorker Administrator Icon (ECS Desktop) 

To invoke NetWorker Backup program, click on the NetWorker Backup icon: 

Figure 4.1.1-2 NetWorker Backup Icon (ECS Desktop) 

To invoke NetWorker Recover program, click on the NetWorker Recover icon: 
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Figure 4.1.1-3 NetWorker Recover Icon (ECS Desktop) 

4.1.1.2 NetWorker Main Screen 

Figure 4.1.1-4 shows the nwadmin screen. For more information on the NetWorker 
Administrator, see the NetWorker Administrator’s Guide. 

Figure 4.1.1-4. NetWorker Administrator’s Screen 
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Figure 4.1.1-5 shows the nwbackup screen. For more information on NetWorker Backup, see the 
NetWorker User’s Guide. 

Figure 4.1.1-5. NetWorker Backup Screen 

Figure 4.1.1-6 shows the nwrecover screen. For more information on NetWorker Recover, see the 
NetWorker User’s Guide. 
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Figure 4.1.1-6. NetWorker Recover Window 

4.1.1.3 Required Operating Environment 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product. To find the documentation for Legatto Networker, refer to the ECS 
Baseline Information System web page, URL http://cmdm.east.hitc.com/. 
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4.1.1.4 Databases 

The $Installed_dir/nsr/index directory maintains a database of files that have been backed up and 
the availability of the backup such as tape number and whether it is online or on a volume of tapes 
that has been migrated. This information is in a proprietary format that can only be read using the 
nwrecover tool. 

4.1.1.5 Special Constraints 

None. 

4.1.1.6 Outputs 

NetWorker provides the capability to print and save contents of a window as a way to maintain 
records of NetWorker activities and configurations. For more information, see Chapter 3, Using 
NetWorker Windows and Menus, NetWorker Administrator’s Guide. 

4.1.1.7 Event and Error Messages 

See Appendix A: Error Messages, NetWorker’s User’s Guide, and Appendix A: Troubleshooting, 
NetWorker Administrator’s Guide. 

4.1.1.8 Reports 

None. 
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4.1.2 DBVision (Future Release) 

TBS 

This is a placeholder for the above tool that will be included in future releases. This tool will also 
accommodate minor functions of SQL Monitor. 
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4.1.3 AMASS 

AMASS is a file storage management system (FSMS) for the UNIX operating system. The 
purpose of AMASS in the EOSDIS Core System (ECS) is to provide an easy-to-use interface to 
large media archives. Media is defined as tape and or optical drives. In terms of hardware, the 
FSMS host in the ECS architecture is a Silicon Graphics Inc. (SGI) Challenge XL. There are two 
main types of media libraries in ECS: 

• StorageTek (STK) Powderhorn using Redwood D3 50GB tapes 

• EMASS AML using IBM 3590 10GB tapes and/or HP 2600 2.6GB optical drives 

STK Powderhorns are used at GSFC, LaRC and EDC. Powderhorns support only tape media. 
Powderhorns consist of 6 major parts, the ACSLS (Automated Console System for Library 
Services) which is a Sun Sparc 5 front end controller, the ACS (Automated Cartridge System), 
CAP (Cartridge Access Port) where tape media are inserted and ejected, the LMU (Library 
Management Unit) interface unit, LCU (Library Control Unit) to control the robot , CD (Cartridge 
Drives) racks which hold up to 4 D-3 tape drives and the LSM (Library Storage Module) which 
includes the robot arms and the tape silo itself. The LSM includes a camera to display operation to 
the operator and the tape drives. Note that ACSLS is connected to the network via Ethernet. 

EMASS AMLs are used at the GSFC and EDC DAACs. AMLs support tape and optical media 
simultaneously. The AML (Automated Media Library) consists of four major parts, the AMU 
(Automated Management Unit) which is an IBM OS/2 microcomputer controller for the AML, the 
Entry Interface Facility (EIF) where media can be inserted or ejected from the AML, the tower 
which is a multilevel turntable that stores the media, the tape and/or optical drives and the robot(s) 
which take the media from the tower to a tape drive (which is called a mount) and from the tape 
drive to the tower (which is called a keep). Note that the AMU is connected to the network via 
FDDI. 

Many ECS AMLs will be running two ‘logical’ jukeboxes because both tape and optical drives will 
be included. This does not change the operation of the system but the operator must be aware to 
use commands going to the correct jukebox. By convention, juke 1 has the tape drives and juke 2 
has the optical drives. 

The software components are more complicated. AMASS itself is the part that the user-of-the
system actually uses. AMASS appears to the user as just another UNIX mount point and to and 
from which one copies, moves or deletes files using standard POSIX cp, mv or rm commands. An 
operator may view the contents of the archive, monitor the system, or setup new tapes for use 
through standard commands found in the Managing the AMASS File System (Version 4.9). As of 
AMASS Version 4.7.1 the volserv program has been replaced by a client/server system called DAS 
(Distributed Archive Server) 1.3 on the AMLs and ACSLS on the STKs. DAS is the ‘glueware’ 
program that acts as a network transport for AMASS to communicate directly with the AMU 
controller software and is loaded on the AMU. Once DAS has been configured correctly, it should 
only need to be monitored unless there is a change to the hardware or for a software upgrade. 
ACSLS combines the functionality of DAS and the AMU software in a single package. Once it has 
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been configured correctly it should only need to be monitored unless there is a change to the 
hardware or for a software upgrade. Telnet is configured on both AMUs and ACSLSs. Lastly, 
there is a component that also runs on the SGI but it has no user configurable parts. 

AMASS is installed on an SGI. Control information is communicated from the SGI to the AMU 
using TCP/IP protocols via FDDI. The following diagram shows the basic route that control 
information takes in sending a file to AMASS to an AML or Powderhorn: 
1. User/application initiates file transfer to AMASS 

2. AMASS receives the file over the network via nfs, ftp, dd or cp or locally via dd or cp to its 
cache 

3. AMASS sends information to the AMU/ACSLS about what tape to load. 

4. The AMU rotates the tower to the correct position, sends the robot to retrieve the tape, 
robot grips and retrieves tape and inserts into tape drive to complete the mount. 

5. File is written to tape. 

AMASS 

FDDI 
LAN 

SGI 

RS232 

nfs/ftp 
1 

2 3 

4 5 

User Command on AMU/ Robotics 
remote host ACSLS 

AML/STK 

Figure 4.1.3-1. Control Path 

The data path is much simpler. A SCSI controller on the SGI is directly connected to the SCSI port 
on the tape drive. Ideally, each drive gets its own controller. After the above process takes place, 
AMASS writes the file to the tape in a very simple block by block method. Note that the format of 
the tape is proprietary and NOT compatible with CPIO or TAR. 

AMASS uses both a command line and a GUI. AMASS is used to perform the system 
administration/operator functions listed in Table 4.1.3-1. 
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Table 4.1.3-1. Common ECS Operator Functions Performed with AMASS 
(1 of 2) 

Operating 
Function 

Command or GUI Description When and Why to Use 

activate or 
deactivate the 
AMASS file 
system 

amassstat 
AA Win GUI 

displays or toggles the 
status of AMASS 
(ACTIVE/INACTIVE) 

used to inactivate the file
system for maintenance 
and/or to reactivate it 

add a volume volnew 
AA Win GUI 

introduces a new volume to 
AMASS and assigns a 
volume number 

to add storage space for data 

add space to a 
volume group 

volnew 
volgroup 
AA Win GUI 

adds additional volumes to 
an existing volume group 

when more space is required 
in an existing volume group 

create a space 
pool 

volnew one or more volumes 
assigned to a special 
volume group of ìSPî 

to allow AMASS to 
automatically add space 
(volumes) to a volume group 
that has run out of space 

create a 
volume group 

volgroup 
setvolgrp 
AA Win GUI 

partitions the volumes in 
AMASS 

to assign volumes for specific 
purposes within AMASS 

delete a 
volume 

volstat 
voldelete 
AA Win GUI 

removes a volume and its 
files from the archive 

to delete a volume and any 
files it contains 

generate a 
report 

amassreport generates formatted report 
and/or raw output 

to extract information about 
files and directories from the 
AMASS index 

back up the 
AMASS index 

amassbackup performs full or partial back 
up of the AMASS index 

any time that the system 
needs to be backed up other 
than what AMASSs 
automatic backup provides 

put a drive into 
service 

drivelist 
drivestat 
AA Win GUI 

displays the current status 
of the drives and to change 
the status 

when an INACTIVE drive is 
ready to return to service 

recover dead 
space 

volspace 
volcomp 
volformat 
AA Win GUI 

compresses a selected 
volume 

to recover dead space on 
volumes 

reinitialize the 
AMASS index 

refer to the vendor 
documentation for 
the command and 
procedure 

clears out the existing index 
and reinitializes it to an 
empty index 

only when AMASS is not 
running 

reintroduce an 
offline volume 

vollist 
volslot 
bulkinlet 

volloc 

reintroduces an offline 
volume to a jukebox 

if data from an offline volume 
needs to referenced for read 
access 
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Table 4.1.3-1. Common ECS Operator Functions Performed with AMASS 
(2 of 2) 

Operating 
Function 

Command or GUI Description When and Why to Use 

remove a 
volume or 
volume group 

vollist, voloutlet, 
volloc 
AMASSADMIN GUI 

removes a volume or an 
entire volume group from 
the jukebox 

to make room for new 
volumes or because data not 
being used needs to be 
retained 

remove space 
from a volume 
group 

vgroot #VG 
setvolgrp /path #VG 
volgroup 

removes space from one 
volume group to add it to 
another 

when space is needed in 
another volume group 

replace a full 
backup 
volume 

voloutlet 1, 
bulkinlet 0, 
vollabel {to rename} 
tapelength 1 2 
volformat -b 256k 1 
amassbackup -fv 

initializes a new backup 
volume and performs a full 
backup 

when the backup volume is 
95% full 

restore the 
AMASS 
database 

amassrestore restores the index either 
completely or to the point of 
the last full or partial backup 

when the index is corrupt on 
the magnetic disk 
do not use the amassrestore 
command when AMASS is 
running 

retrieve 
system usage 
by user 

amassreport displays the number of files 
and directories owned by a 
user and the amount of 
space they take up 

to get statistical information 
on the amount of space used 
by an individual(s) 

retrieve 
system usage 
by volume 

adf displays volume group, 
jukebox reference number, 
position of volume, amount 
of used space, number of 
directories and files on 
volume, amount of free and 
dead space 

to get statistical information 
about the usage of a 
particular volume 

reuse a 
volume 

(volcomp, volstat, 
volclean, volformat 
AA Win GUI 

compresses and moves 
existing data to another 
volume, then reformats the 
volume 

when a volume contains data 
no longer needed or 
contains mostly dead space 

take a drive 
out of service 

drivelist, drivestat 
AA Win GUI 

displays and changes the 
status of the drive 

when a drive has excessive 
failures or for maintenance 

4.1.3.1 Quick Start Using AMASS 

For more information about AMASS, refer to the Managing the AMASS File System and Using 
The AMASS GUI guides. 

The documentation of AMASS used as a basis and referenced in this section is for AMASS 4.9. 
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4.1.3.1.1 Invoking AMASS From the Command Line Interface 

AMASS is normally started at boot and shutdown when the system is shutdown using scripts in 
the /etc/rc2.d and /etc/rc0.d directories that are linked to the actual scripts in /etc/init.d. AMASS can 
also be started and stopped from the command line. 
To execute AMASS from the command line prompt use: 

/usr/amass/tools/amass_start 

To stop AMASS, type: 

t1drg01 100> /usr/amass/tools/killdaemons 

AMASS startup at boot can be enabled or disabled using the amass_atboot command. For 
more information on accessing AMASS via the command line, refer to Chapter 3, Command 
Reference, Managing the AMASS File System.. 

The AMASSADMIN GUI can be started from the command line by typing 

/usr/amass/bin/aawin 

For more information on running the AMASS, refer to Using The AMASS GUI guide. 

For a description of AMASS commands and the functions they perform, see Chapter 2, 
Operational Tasks, and Chapter 3 , Commands of the Managing the AMASS File System. 

4.1.3.1.2 Invoking AMASS From the ECS Desk top. 

There is no icon on the ECS Desktop for AMASS. Currently, the AMASS GUI is activated with a 
command line script as described in the previous section. 

4.1.3.2 AMASS Main Screen 

AMASS allows the operator to perform a subset of the command line functions, as well as query 
online index and output results to a file for further processing. For more information on the 
AMASS, refer to Using the AMASS GUI guide. 

The window area of the AMASS Main Screen is referred to as ‘The Workroom’. 
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Figure 4.1.3-2. AMASS Main Screen (AAWIN) 

AAWIN Pulldown Menu options: 

File 

Exit:  Exits AMASS. 

Clear Workroom:  Clears the Workroom of all icons. 

Tasks 

Modify a Volume Group 

Modify a Volume 

Admin 

Scheduler:  Opens the Scheduler Status window. 
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Sysperf:  Opens the sysperf window displaying the status of the AMASS activity. 

Preferences 

Show/Hide Detail Windows:  These windows give a brief description of the items the 
mouse pointer is touching. 

Help:  Opens the Help Window. 

AMASS Utility Bar options (the Utility Bar is a vertical toolbar on the right side of the Main 
Screen) 

Trash Can icon


Volume Group icon displays the volume group icons in the Workroom


Volume icon displays volume icons in the Workroom.


Figure 4.1.3-3. AMASS Main Screen showing selected volumes 
in the Workroom 
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4.1.3.3 Required Operating Environment 

AMASS requires a UNIX environment. AAWIN requires an X-window server. 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product. To find the documentation for AMASS, refer to the ECS Baseline 
Information System web page, URL. 

http://cmdm.east.hitc.com/. 

4.1.3.3.1 Interfaces and Data Types 

The commands and the AMASS GUI that operations staff use to interface with AMASS are 
described in the Managing the AMASS File System and Using The AMASS GUI. 

4.1.3.4 Databases 

The File Storage Management System provided by EMASS Company includes the RAIMA 
database product. AMASS utilization of the database is transparent to the operator. 

4.1.3.5 Special Constraints 

None. 

4.1.3.6 Outputs 
Output from the AMASS consists of the data displayed on the GUI described in section 4.1.3.2, 
database updates or additions to the database referenced in section 4.1.3.4, error and event 
messages described in section 4.1.3.7, and reports described in section 4.1.3.8 which may 
produce files output in response to user actions or are printed. 

4.1.3.7 Event and Error Messages 

AMASS generates the following types of messages: 

•	 Informational (AMASS_I): Informational messages inform you about a process or 
situation. The status of AMASS is not changed when you receive an informational 
message. 

•	 Warning (AMASS_W): Warning messages inform you of situations that require 
attention but do not inhibit the functioning of AMASS. 

•	 Error (AMASS_E): Error messages require the immediate attention of the System 
Administrator to insure the proper functioning of AMASS. 

•	 System (AMASS_S): System messages indicate internal errors and should be reported 
to the EMASS Technical Assistance Center (ETAC).. 
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AMASS uses the standard syslogd function of the operating system for all of its warning, error 
and system messages. This facility allows the system administrator to control the output 
destination(s) of these messages. 

With the /etc/syslog.conf file, the operator can control the destination of each of the message types. 
The syslog.conf file is typically set up to log all levels of AMASS messages to var/adm/messages. 
The console is typically set up to see all AMASS levels generated by the kernel facility and the 
system and error level generated by the daemon facility. 

For a description of AMASS event and error messages, refer to and Errors Corrective Action 
manual. 

4.1.3.8 Reports 

AMASS reports provide information of the AMASS holdings using the amassreport report 
generator. Specific reports may be tailored for specific information on the basis of selections by 
date, file, directory, errors, length, size, or IDs. All reports have the column heading listed in 
Table 4.1.3-2. 

Table 4.1.3-2. Amassreport Column Headings 
Heading Description 

Name Name of file 

Parent Record ID of Parent. 

Last Accessed Last Accessed date on timestamp. 

Mode Permission IDs. 

Size File size in MegaBytes 

File ID File Number. 

UID User ID 

GID Group ID 

Last Modified Date and time showing date the file was last modified. 

Vol File is located on this volume number. 

Table 4.1.3.-3 below lists two types of AMASS reports using the amassreport command. 

Table 4.1.3-3. Amassreport Report Types 
Output Description and Format 

formatted report prints a column header at the top of each page 

raw output prints data without a column header 
can be used with other utilities to generate custom reports 

The content of both types of tables is the same. The raw output type is meant to be used to provide 
input for further processing to a more complete reporting system. 
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For information on using amassreport see Chapter 3, Command Reference, Managing the 
AMASS File System. 

4.1.3.8.1 Sample Report 

Below is an example of a formatted amassreport showing volume group 20. 

NAME FILEID PARENT UID GID LAST MODIFIED LAST ACCESSED MODE


VOL SIZE


file_create 23 2 3137 20 Oct 21 10:06 Nov 06 18:17 drwxrwxr-x


20 0


testfiles1 171147 23 435 20 Oct 22 08:57 Nov 04 06:32 drwxr-xr-x


20 0


random_files 333451 23 435 20 Sep 11 1996 Nov 04 08:04 drwxr-xr-x


20 0


portioned_random_files 1751199 23 3137 20 Sep 25 1996 Nov 04 08:04 drwxr-xr-x


20 0


logs_tape 2975809 2 435 20 Oct 22 1996 Nov 03 23:01 drwxrwxr-x


20 0


Figure 4.1.3-4. Amassreport example showing Volume Group 20 
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4.1.4 ISQL 

Interactive SQL (ISQL) is a stand-alone SQL command parser utility provided with the Sybase 
SQL Server and is available on all platforms that Sybase is available. ISQL is executed directly 
from the operating system level, and is used to interact with a SQL server and the databases on a 
SQL server. It allows for the interactive issuance and execution of Sybase Transact-SQL 
statements and sends the Transact-SQL commands to the SQL Server, formatting the results and 
printing them on the standard output. ISQL is used to perform the operator functions listed in Table 
4.1.4-1. 

Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL 
(1 of 3) 

Operating 
Function 

Command/Script Description When and Why to 
Use  

Monitor 
database and 
user activity 

See Chapter 1 - Overview 
of System Administration 
in the System 
Administration Guide for 
SQL Server 

There are various 
database management 
activities performed in 
Sybase SQL Server to 
keep the databases 
running for day-to-day 
operations 

Database and user activity 
is monitored to manage 
and control various day
to-day operations of the 
DAAC and to prevent or 
resolve any unforeseen 
problems 

Provide and 
control users' 
database 
access 

• See Chapter 4-
Managing SQL Server 
Logins and Database 
Users in the System 
Administration Guide for 
SQL Server 

• See Chapter 5 -
Managing User 
Permissions in the 
System Administration 
Guide for SQL Server 

• Create user accounts, 
set account default 
databases and other 
account configurable 
items 

• Grant proper 
permissions to user 
accounts 

• It may be necessary to 
provide access to 
individual users or 
groups of users on a 
temporary, permanent, 
or on-demand basis 

• Access to data at the 
DAAC should be 
controlled so it is not 
accidentally deleted, 
modified, or obtained 
without permission 
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Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL 
(2 of 3) 

Operating 
Function 

Command/Script Description When and Why to 
Use  

Grant roles 
and assign 
various 
privileges on 
database 
objects 

See Chapter 2 - Roles in 
SQL Server in the System 
Administration Guide for 
SQL Server 
Chapter 5 - Managing User 
Permissions in the System 
Administration Guide for 
SQL Server 

Roles and user accounts 
are necessary to provide 
access and security to 
databases under 
Sybase SQL Server 

• Proper database 
management roles such 
as SSO (System 
Security Officer), SA 
(System Administrator), 
OPER (Operator) are 
essential to the proper 
management of the 
databases at DAACs 

• Providing the proper 
level of privileges to 
each user of the 
databases prevents any 
accidental or 
unforeseen mishaps 
with the data (data 
integrity is also 
maintained) 

Monitor, 
control, and 
manage the 
use of disk 
space, 
memory and 
connections 

See Chapter 3 - Managing 
Physical Resources in the 
System Administration 
Guide for SQL Server 
Chapter 6 - Checking 
Database Consistency in 
the System Administration 
Guide for SQL Server 

• All databases running 
under Sybase SQL 
Server are physically 
stored on various 
devices and require 
various amounts of 
memory based on the 
usage of data 

• These resources have 
to be properly 
monitored 

• Resources for storage 
and manipulation of 
data are always at a 
premium 

• Proper management of 
these resources is 
essential in reducing 
errors, database 
crashes and unwanted 
downtime 
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Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL 
(3 of 3) 

Operating 
Function 

Command/Script Description When and Why to 
Use  

Backup and 
restore 
databases 

• See Chapter 7 -
Developing a Backup 
and Recovery Plan in the 
System Administration 
Guide for SQL Server 

• Chapter 8 - Backing up 
and Restoring user 
databases, in the System 
Administration Guide for 
SQL Server 

• Chapter 9 - Backing up 
and Restoring the 
system databases in the 
System Administration 
Guide for SQL Server 

Backup of databases 
provides for quick 
recovery and 
maintenance of data 
integrity 

• Most Database 
Administrators perform 
a daily backup of all their 
databases and perform 
recovery operations 
when a database 
crashes and is 
unrecoverable by other 
recovery methods 

• Proper backup and 
recovery plans allow for 
full, quick recovery and 
zero loss of data 

• Regular backup of data, 
is essential in reducing 
downtime in case of a 
database crash 

Diagnose 
system 
problems 

• See Chapter 11 -
Diagnosing System 
Problems in the System 
Administration Guide for 
SQL Server 

• Also see the SYBASE 
SQL Server 
Troubleshooting Guide 

• Diagnosing problems 
with the operation of 
SQL Server is a regular 
part of database 
administration tasks 

• ISQL is used as a 
command line tool for 
interfacing with the 
SQL Server 

• Anytime the SQL server 
is not performing 
according to 
expectation or any 
database on SQL 
Server has crashed, the 
problem(s) must be 
diagnosed by checking 
current SQL Server 
status information 

• All problems must be 
properly resolved for 
successful operation of 
SQL Server 

Fine-tune 
SQL server 
performance 

See Chapter 12 - Fine
tuning Performance and 
Operations in the System 
Administration Guide for 
SQL Server 

A continuous operations 
and administration 
activity that may involve 
any of the above 
activities to make sure 
SQL Server makes best 
use of its resources and 
to gain maximum 
performance from SQL 
Server 

The SQL Server is fine
tuned whenever storage 
or data requirements 
have changed, number of 
users have changed, new 
databases are added or 
existing databases are 
deleted, any SQL Server 
settings are modified, or 
any external environment 
changes have occurred 
which may impact the 
SQL Server 
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In addition, the DAAC user community may use ISQL to: 

• request data from various databases by issuing Transact-SQL statements 
• insert, update, or delete data from various databases by issuing Transact-SQL statements 
• change their passwords 

4.1.4.1 Quick Start Using ISQL 

This section presents an orientation of ISQL. For more information on ISQL, refer to the SQL 
Server Utility Programs for UNIX. 

Other manuals that the operator may find useful are: 

• System Administration Guide for SQL Server (SQL Server administration issues) 
•	 System Administration Guide Supplement (operating-system specific system administration 

tasks) 
•	 Open Client DB-Library/C Reference Manual (man pages and code samples for the SQL 

Server interface library, Open Client DB-Library) 
• The SQL Server Installation Guide (installation procedures for SQL Server) 
• SQL Server Reference Manual Vol. 1 and Vol. 2( commands and system procedures) 

These and other Sybase manuals can be found online at the SyBooks Online Publications page at: 

http://www.sybase.com/Offerings/Sybooks/books.html 

The documentation of ISQL used as a basis and referenced in this section is for version 10.0.4 
contained in ECS Release 4. This tool is a COTS product provided by ECS. 

4.1.4.1.1 Invoking ISQL From the Command Line Interface 
To execute ISQL from the command line prompt use: 

isql 

For detailed instructions on how to invoke ISQL see Chapter 3 - Using ISQL in the SQL Server 
Utility Programs for UNIX guide. 

4.1.4.1.2 Invoking ISQL From the ECS Desk top. 

There is no icon on the ECS Desktop for ISQL. Currently, the ISQL is activated with a command 
as described in the previous section 

4.1.4.2 ISQL Main Screen 

There is no ISQL GUI. The ISQL uses the command line interface for operator communications. 

4.1.4.3 Required Operating Environment 

The utility program ISQL is invoked directly from the UNIX operating system via the command 
line. 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
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document for each product. To find the documentation for ISQL, refer to the ECS Baseline 
Information System web page, URL http://cmdm.east.hitc.com/. 

4.1.4.3.1 Interfaces and Data Types 

SQL Server requires an interfaces file to map logical server names to physical network information about 
those servers. The interfaces file includes server name, network address, and the port number on which 
the server listens on for queries. For detailed information on the interfaces files please see the Open 
Client/Server Supplement for your operating system. 

4.1.4.4 Databases 

For more information on Sybase SQL Server databases, refer to the SYBASE SQL Server System 
Administration Guide. 

4.1.4.5 Special Constraints 

None. 

4.1.4.6 Outputs 

Output from the ISQL consists of database updates or additions to the databases referenced in 
section 4.1.4.4, and error and event messages described in section 4.1.4.7. 

ISQL does not provide formatting options for the output, but the -n option eliminates ISQL 
prompts, while -e will include each command issued to ISQL in the output. Other tools can then be 
used to reformat the output. For further information on formatting ISQL output please see the SQL 
Server Utility Programs for UNIX manual. 

4.1.4.7 Event and Error Messages 

Sybase SQL Server issues both status and error messages from the SQL Server and ISQL formats 
them to the designated output. For details on setting output options for ISQL the SQL Server 
Utility Programs for UNIX manual. 

For more information on error messages, their cause and corrective actions, refer to the SYBASE 
SQL Server Error Messages manual. 

4.1.4.8 Reports 

None. 
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4.1.5 SQR Report Writer (Future Release)


TBS


Note: This is a placeholder for the above tool that will be included in future releases.
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4.1.6 Intelligent Query and IQ Access (IQ) (Future Release) 

TBS


This is a placeholder for the above tool that will be included in future releases.
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4.1.7 Sybase Replication Server 

Sybase Replication Server is a COTS product used by PDPS and SUBSRV to maintain warm 
standby copies of their application data, and by MSS, IOS, and DMS to replicate changes among 
databases at different sites. Replication Server and its cooperating components provide services to 
detect changes in a primary database and reliably apply them in one or more replicate databases 
based on configurable criteria. This infrastructure contains features to maintain transactional 
integrity in replicate databases and guarantee data delivery even if some components are down for 
a period of time. 

Replication Server manages replicated data via replication definitions, subscriptions and function 
strings. These objects are maintained in order to control what data is replicated and how it is 
applied in the replicate database. 

Warm standby, as used by PDPS and SUBSRV, maintains an up-to-date copy of the database on 
a separate server. This copy can become the primary database if any hardware or software needed 
by the primary fails. 

The IOS, DMS, and MSS subsystems also use a replication system to replicate whole tables and 
in some cases, selected rows, among several sites. Replication Server provides the reliable 
mechanism for managing and synchronizing several copies of the same database without much 
additional coding. 

The Sybase Replication Server does not require much attention once its properly configured. Table 
4.1.7-1 summarizes administrative functions associated with an evolving replication system. 

Table 4.1.7-1. Common ECS Operator Functions Performed with 
Sybase Replication Server (1 of 2) 

Operating Function Description When and Why to Use 

Add a warm standby 
database 

Instructions begin on pg. 11
12 of Replications Server 
Administration Guide. 

Used by system administrator to 
implement a warm standby for a 
selected database. 

Add a primary database Instructions begin on pg. 9-2 
of Replications Server 
Administration Guide. 

Used by the system administrator 
when a new primary database must 
be added to the system. 

Add a replicate database Instructions begin on pg. 9-2 
of Replications Server 
Administration Guide. 

Used by the system administrator 
when a new replicate database 
must be added to the system. 

Mark a table for 
replication 

Instructions begin on pg. 5-20 
of Replications Server 
Administration Guide. 

Used by system administrator to 
configure a table for replication or a 
warm standby. 
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Table 4.1.7-1. 	 Common ECS Operator Functions Performed with 
Sybase Replication Server (2 of 2) 

Operating Function Description When and Why to Use 

Create, Modify, Delete a 
replication definition 

Instructions begin on pg. 5-10 
of Replications Server 
Administration Guide. 

Used by system administrator to 
configure a table containing primary 
data for replication. Also necessary 
for warm standby tables that meet 
certain criteria, i.e. have more than 
128 columns. 

Create, Modify, Delete a 
replication subscription 

Instructions begin on pg. 7-1 
of Replications Server 
Administration Guide. 

Used by the system administrator to 
configure a replicate data table. 

Monitor the replication 
system 

Instructions are on pgs. 3-12, 
4-9, 7-25, 9-22 and 11-27 of 
Replications Server 
Administration Guide 

Used by the system administrator to 
periodically monitor the replication 
system. 

Configure a coordinated 
database dump 

Instructions begin on pg. 3-48 
of Replications Server 
Administration Guide. 

Used by system administrator when 
a new database is added to the 
system. 

Switch the active and 
standby databases 

Instructions begin on pg. 11
23 of Replications Server 
Administration Guide. 

Used by the system administrator 
when the primary database (with a 
warm standby) fails or comes back 
on line. 

Recover a database 
from a coordinated 
dump 

Instructions begin on pg. 14
12 and 14-38 of Replications 
Server Administration Guide. 

Used by the system administrator 
following a catastrophic database 
failure. 

Recover from a stable 
queue device failure 

Instructions begin on pgs. 14
3 and 14-30 of Replications 
Server Administration Guide. 

Used by the system administrator if 
a device containing a stable queue 
fails. 

Recover from a 
truncated primary 
database log error 

Instructions begin on pg. 14-8 
and 14-38 of Replications 
Server Administration Guide. 

Used by system administrator if the 
database transaction log is 
truncated before replication server 
can read it. This should never 
happen in a production database! 

Recover from 
Replication Server 
System Database 
(RSSD) failure 

Instructions begin on pg. 14
15 of Replications Server 
Administration Guide. 

Used by the system administrator if 
a device containing the RSSD fails. 

Quiese the replication 
system 

Instructions begin on pg. 3-49 
of Replications Server 
Administration Guide. 

Used by system administrator to put 
system in a quiet state to complete 
other configuration tasks. 

4.1.7.1 Quick Start Using Sybase Replication Server 

Replication Server is part of a cooperating group of products designed to dynamically capture data 
changes as they occur and reliably apply them to other databases. Figure 4.1.7-1 illustrates the 
various components of a replication system. 
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Data 

Disk IO 
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Figure 4.1.7-1. Replication System Components 

All of the replication system processes were developed using the Open Client/Open Server 
interface. This interface provides the necessary communications and translation services which 
allow these processes to reside on different hardware and software platforms. This interface also 
gives system administrators the capability to configure and control all components via a single 
tool. 

The Replication Server is the central component of this system. It receives database changes from 
log transfer managers (LTM) and stores them in local stable queues until they can be delivered to 
subscribing replicate databases. The stable queues reside on local raw partitions and provide 
persistent storage for in transit data. 

The log transfer manager reads a database’s transaction log and delivers selected records to the 
replication server. The LTM is a separate process which can only service one database. It is a 
required component for any database which contains data that will be replicated (primary data). 

The replication server does not maintain replication configuration data locally. It stores this data in 
a Replication Server System Database (RSSD), which is managed by a Sybase SQL Server. The 
RSSD can be managed by any available database server. It does not require a dedicated resource 
as used in the figure above. 
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This is a highly customizable system, which gives developers the capability to select databases, 
tables, specific rows or columns for replication. The entire system is built on an open interface, 
giving it the capability to work with many vendor’s databases and perform various levels of data 
conversion as needed. 

The documentation of Replication Server used as a basis and referenced in this section is for 
version 11.0.3, contained in ECS Release 4. This tool is a COTS product provided by ECS. 

4.1.7.1.1 Invoking Sybase Replication Server From the Command Line 
Interface 

The Replication Server and LTMs run as UNIX daemon processes. System administrators create 
run server files during the installation process to invoke a replication server or an LTM with the 
necessary parameters. The run server files normally reside in the $SYBASE/install directory and 
are invoked via the startserver command using the following syntax: 

To execute Sybase Replication Server from the command line prompt use: 

$SYBASE/install/startserver -f $SYBASE/install/runserver.file 

Ideally, the necessary startserver commands should be included in the appropriate operating system 
startup resource files. This ensures that the component is operational if the system is rebooted. 

The replication system can be configured and monitored through various command line utilities 
which are documented in the Replication Server Commands Reference. Table 4.1.7-2 summarizes 
these commands. 

Table 4.1.7-2. Replication Server Command Line Interface 
Command Description and Format When and Why Used 

rs_init Replication Server configuration program. Used to configure the 
Replication Server, configure 
database connections, and 
administer the replication server 
(i.e., add databases). 

isql Standard Open Client interface for all 
replication system components. It can 
interactively send commands to a 
component or can read commands from a 
script file. Most successful system 
administrators use script files to document 
changes and restore the system as required. 

Used for most replication server 
configuration and some 
monitoring functions. 

rs_subcmp Synchronizes a primary and replicate table. Used when a replication server 
logs data loss messages for a 
specific replicate table. 
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4.1.7.1.2 Invoking Sybase Replication Server From the ECS Desk top. 

There is no icon on the ECS Desktop for Sybase Replication Server. Currently, the Sybase 
Replication Server is activated with a command line script as described in the previous section. 

4.1.7.2 Sybase Replication Server Main Screen 

There are no GUIs associated with the Sybase Replication Server. 

4.1.7.3 Required Operating Environment 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product. To find the documentation for Sybase Replication Server, refer to the 
ECS Baseline Information System web page, 

URL http://cmdm.east.hitc.com/. 

4.1.7.3.1 Interfaces and Data Types 

Sybase Replication Server exchanges data of various types through interfaces within ECS. Table 
4.1.7-3 lists Sybase Replication Server system interfaces for Version 2.0. 

Table 4.1.7-3. Replication Server Interfaces Protocols 
Interface Type of Primary 

Interface 
Protocols 

Comments 

LTM to Replication 
Server 

Log Transfer 
Language (LDL) 

Sybase developed protocol/API which works 
over Open Client. Sybase distributes the 
necessary libraries and documentation to LTM 
developers. This layer is completely 
transparent to ECS subsystems. 

Inter component 
communications 

Open Client Sybase developed protocol/ API which works 
over TDS. This is a popular client/ server 
interface which provides reliable platform 
independent communications. 

Inter component 
communications 

Tabular Datastream 
Protocol (TDS) 

Sybase proprietary protocol used with Open 
Client and Open Server applications. 

4.1.7.4 Databases 

The Replication Server and LTM use a configuration file and the RSSD to store their configuration 
information. The configuration files generally contain basic information used to locate and log into 
the RSSD and other Replication Servers. Both processes get most of their configuration 
information from the RSSD or another Replication Server which is connected to an RSSD. 
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Replication Server and the LTMs also get transaction status information from the primary and 
replicate databases. This information is stored in the rs_lastcommit, and rs_threads tables and in 
internal database server structures. These structures can be accessed via the dbcc settrunc and dbcc 
settrunc SQL Server commands. 

4.1.7.4.1 Server Configuration File 

The server configuration file contains startup information for the Replication Server and LTM. 
These processes use this information to connect to the RSSD or another Replication Server. The 
format for these text files is documented in the Replication Server Installation Guide. 

4.1.7.4.2 Replication Server System Database (RSSD) 

The RSSD contains most of the Replication Server’s configuration information. This information 
includes replication definitions, subscriptions and function strings along with the exceptions log. 
This database also contains stored procedures for viewing these tables. These procedures and the 
RSSD schema are documented in the Replication Server Commands Reference. 

4.1.7.4.3 Commonly Used RSSD Stored Procedures 

Table 4.1.7-4 contains a summary of commonly used RSSD stored procedures. The Replication 
Server Commands Reference contains a complete listing of all stored procedures along with 
detailed documentation. 

Table 4.1.7-4. Commonly Used RSSD Stored Procedures 
Procedure Description When/Why Used 

rs_helprep Displays a list of all replication 
definitions or detailed information 
for a specific replication definition. 

Used by developers and system 
administrators when developing or 
debugging replication definitions. 

rs_helpsub Displays a list of all subscriptions 
or detailed information for a 
specific subscription. 

Used by developers and system 
administrators when developing or 
debugging subscriptions. 

rs_helpfstring Displays function strings for a 
replication definition or detailed 
information for a specific function 
string. 

Used by developers and system 
administrators when developing or 
debugging function strings. 

rs_helpexception Displays a list of transactions in the 
exceptions log or detailed 
information for a specific 
transaction. 

Used by the system administrator to 
troubleshoot failed transactions in a 
replicate database. 

rs_configure Displays values for configuration 
parameters or changes a specific 
parameter. 

Used by system administrators to tune 
a Replication Server. 
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4.1.7.5 Special Constraints 

The Replication Server uses the “maintenance user” login and password to connect to primary and 
replicate databases to perform transactions. Replication Server uses primary users to perform 
certain operations such as adding replicated objects (i.e. replication definitions and subscriptions). 
Replication Server administrators and developers must have consistent logins and passwords 
throughout the replication system. These users also require specific permissions on the replication 
server and in the primary and replicate databases to accomplish certain tasks. Pages 4-11 through 
4-16 of the Replication Server Administration Guide documents these access requirements. 

4.1.7.6 Outputs 

Output from the Sybase Replication Server tool consists of the database updates or additions to the 
database referenced in section 4.1.7.4 as well as error and event messages described in section 
4.1.7.7. 

4.1.7.7 Event and Error Messages 

Each component in the replication system has its own error log. Components write both 
informational and error messages to these logs depending on the state of various trace flags. The 
component administration and troubleshooting guides, TBS, document the trace flags and the 
messages contained in the respective log files. Table 4.1.7-5 summarizes the types of log files 
used in the replication system. 

Table 4.1.7-5. Replication System Log Files 
Output Description and Format 

Replication 
Server 
Error Log 

Contains Replication Server specific informational and error messages. The format 
and messages in this file are documented in the Replication Server 
Troubleshooting Guide. 

LTM Error 
Log 

Contains LTM specific informational and error messages. The format and messages 
in this file are documented in Replication Server Troubleshooting Guide. 
NOTE: Some LTM messages are also duplicated in Replication Server Error Log. 

SQL 
Server 
Error Log 

Contains SQL Server specific informational and error messages. The format and 
messages in this file are documented in the SQL Server Troubleshooting Guide 
and in the SQL Server Error Messages Reference. 
NOTE: RSSD error messages will also appear in Replication Server Error Log. 

None of the replication systems currently use custom error messages. 

4.1.7.8 Reports 

None. 
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4.1.8 Global Change Master Directory (GCMD) (Future Release) 

TBS


Note: this is a placeholder for the above tool that will be included in future releases.
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4.1.9 MIB Browser 

The ECS Management Information Base (MIB) Browser is a resource management tool for ECS 
applications. The MIB is a data file associated with each computer in the ECS system. The MIB 
defines the parameters used by the ECS performance monitoring components to control access to 
information in the host computer. A GUI interface allows users to manage these performance 
variables on ECS applications. 

ECS 
Apps 1 

ECS 
Apps 2 

ECS 
Apps n 

nth apps 

.cfg 
files 

ECS MIB 
Browser GUI 

Deputy 
Agent 

Master 
Agent 

SNMP 

Sub- Agent 

E CS HOST 

RPC Event 

OPEN VIEW 

SNMP 

Figure 4.1.9-1. Representation of MIB Browser Operating Environment 

Table 4.1.9-1 summarizes the operator functions that the MIB Browser supports. 
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Table 4.1.9-1. Common ECS Operator Functions Performed with 
the ECS MIB Browser 

Operating 
Function 

Command Description When and Why to Use 

Determine 
Management 
Information 
available on ECS 
host computers 

Up Tree, Down 
Tree, Describe 

Displays the MIB 
variables defined for 
ECS hosts. 
Provides a 
description of the 
variables. 

• To identify the variables defined 
for a specific host. 

• To determine the meaning of the 
variable 

Display MIB 
variable values 

Start Query, Stop 
Query 

Displays the 
selected MIB variable 
values. 

• To view or capture the MIB variable 
values 

Display graphs of 
the Management 
Information 

Graph Generates a chart of 
the selected MIB 
variable values. 

• To provide a visualization of the 
data for analysis. 

Set MIB variable 
values 

SET Sets the selected 
MIB variable to the 
input value. 

• When it is necessary to reset a MIB 
variable value. 

4.1.9.1 Quick Start Using MIB Browser


4.1.9.1.1 Invoking MIB Browser From the Command Line Interface


The ECS MIB Browser can not be invoked from the command line. The MIB Browser is 
activated from HP Open View as described in the Section 4.1.9.1.2. 

4.1.9.1.2 Invoking MIB Browser From Open View 

In the Open View GUI , select Misc from the Desktop bar and choose MIB Browser from the 
displayed menu. 
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Figure 4.1.9-2. HP OpenView GUI showing Desktop bar 

4.1.9.1.3 Invoking MIB Browser From the ECS Desk top. 

There is no icon on the ECS Desktop for MIB Browser. Currently, the MIB Browser is activated 
from HP Open View as described in the Section 4.1.9.1.2. 

4.1.9.2 The ECS MIB Browser Main Screen 

Figure 4.1.9-3 below presents the ECS MIB Browser Main screen. 
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Figure 4.1.9-3. MIB Browser GUI 
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For a description of the ECS MIB Browser GUI Toolbar, see Table 4.1.9-2 below. 

Table 4.1.9-2. ECS MIB Browser GUI Toolbar 

File Click on File on the ECS MIB 
Browser GUI Toolbar. 

Pull down menu showing Save As and Close 
selections. 

Save As Once in the File, click on Save 
As. 

To save results of ECS MIB Browser in any file 
or directory. 

Close Once in the File, click on 
Close. 

To exit the ECS MIB Browser. 

View Click on View on the ECS MIB 
Browser GUI Toolbar. 

Pull down menu showing Change Selection 
and Object Identifier As Text selections. 

ChangeSelection Once in View, click on Change 
Selection. 

Selects the ECS Host. 
The selected ECS Host will be shown in the 
Name or IP Address field. 

Object Identifier As 
Text 

Once in View, click on Object 
Identifier As Text. 

The host object is identified as Text. 

Help GUI Toolbar Describes a specific object or an application 
parameter, and explains its functionality. 

For a description of the ECS MIB Browser GUI, see Table 4.1.9-3 below. 

Table 4.1.9-3. ECS MIB Browser Field Descriptions (1 of 4) 
ECS MIB 

Browser GUI 
(main screen 

Command/ 
Script or GUI 

Description When and Why to Use 

Name or IP 
Address 

GUI window Text field 
(mandatory) 
Internet Protocol 
address of the host 
that is running. 

Type the IP address in the window, or 
select the host using Change Selection in 
the View. 

Mode GUI window Text field 
(mandatory) 
Mode id of the host 

Narrow scope; Values concerning that 
mode only. Currently not being used. 

Community Name GUI window Text field 
Password for each 
host. 

All ECS hosts are required to provide 
specific Community Name. 
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Table 4.1.9-3. ECS MIB Browser Field Descriptions (2 of 4)

ECS MIB 

Browser GUI 
(main screen 

Command/ 
Script or GUI 

Description When and Why to Use 

MIB Object ID GUI window Text field 
(mandatory). 
Shows the root 
directory 

To collect information on a specified 
application using the MIB Browser, the 
following must be running 
Specified application 
Master Agent 
Sub-Agent 
Deputy Agent. 

Application 
Program 

Process 

MIB 
directory/file 
structure 
window 

Shows the structure 
of MIB directory/file 
in this window. 
Application is the 
highest level, 
followed by Program 
Level, and lastly the 
Process Level. 

Double clicking on the Application Level, 
displays the directory and file structure in 
the window. 
Highlight the Application. 
Navigate up or down in the file structure 
using the Up Tree or Down Tree buttons. 
User must start at the Application Level 
(highest level), and then navigate down to 
the Program Level (middle level) or the 
Process Level (lowest level). 
Application Level is divided into five 
categories. These are: 
static tables (appStTable), dynamic 
tables (appDyTable), performance tables 
(appPerfTable), fault tables 
(appFaultTable), and configuration tables 
(appCfgTable). 
Program Level is divided into four 
categories, namely: 
progStTable, progDyTable, 
progFaultTable, and progCfgTable 
Process Level is divided into three 
categories, namely: 
procDyTable, procPerfTable, and 
procFaultTable 
Within each category, there are many 
parameters. For the dynamic, 
performance, and fault tables, thresholds 
and polling intervals can be set. 

Up Tree GUI button For navigating 
upwards in the 
directory and file 
structure. 

Highlight a directory or file, in the 
Application, Program or Process level in 
the MIB structure window, and then click on 
the Up Tree button to navigate upwards. 
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Table 4.1.9-3. ECS MIB Browser Field Descriptions (3 of 4)

ECS MIB 

Browser GUI 
(main screen 

Command/ 
Script or GUI 

Description When and Why to Use 

Down Tree GUI button For navigating 
downwards in the 
directory and file 
structure. 

Highlight a directory or file, in the 
Application, Program or Process level in 
the MIB structure window, and then click on 
the Down Tree button to navigate 
downwards. 

Describe GUI button Displays the 
Describe MIB 
Variable GUI. 
This GUI displays the 
NAME of the 
application, 
OBJECT ID, TYPE 
of application, and 
DESCRIPTION of 
the application. It 
also has a Close 
button to close the 
GUI and return to 
ECS MIB Browser 
GUI. 

Once the Name or IP Address, Mode, 
Community Name and MIB Object ID fields 
within the ECS MIB Browser are filled in 
completely, then additional information 
about the specific MIB Variable can be 
attained by pressing the Describe button. 
This displays the Describe MIB Variable 
Pop-up (Figure 4.1.9-4). 

Start Query GUI button Starts the query on 
the highlighted 
application in the 
MIB directory/file 
structure window of 
the ECS MIB 
Browser GUI. 
Only one application 
can be selected at 
one time to perform 
query on. 

Highlight the application in the directory/file 
structure window. 
Click on the Start Query button. 
This will populate the MIB Values screen 
with the results of the query. 
Use scroll bars to view complete results, if 
needed. 

Stop Query GUI button Stops the query on 
an application. 

Click on the Stop Query button to stop 
query on an application. 

Graph GUI button Displays the Graph 
GUI, and shows 
query results 
graphically. 

After the results of the query are displayed 
in the MIB Values screen, click on the 
Graph button. 
Graph GUI represents the query results 
graphically. A helpful visual tool for 
checking the performance of applications. 
This displays the Graph GUI Pop-up (Figure 
4.1.9-5). 
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Table 4.1.9-3. ECS MIB Browser Field Descriptions (4 of 4)

ECS MIB 

Browser GUI 
(main screen 

Command/ 
Script or GUI 

Description When and Why to Use 

Set GUI button Certain thresholds 
and polling intervals 
for dynamic tables, 
performance tables, 
and fault tables for 
Application, 
Program or Process 
Level can be set by 
using the Set 
button. 

Once the query results from the selected 
application are shown in the MIB Values 
screen, highlight which MIB Value 
parameter needs to be changed. 
Highlighting the MIB parameter value in the 
MIB Values screen, will show current values 
in the MIB Instance and MIB Set Value 
fields. 
Click inside both fields, and type in the 
desired values. 
Click on the Set button. This will set the 
new values for that parameter. 
Now every time the thresholds for those 
parameters are exceeded, it will log the 
event into the log file. 

MIB Instance GUI window Displays the current 
MIB Instance for the 
application 
parameter. 

Displays the MIB Instance for an application 
parameter. 
Can set it by typing in the MIB Instance field 
(See Set function). 

MIB Set Value GUI window Displays the current 
MIB Value for the 
application 
parameter. 

Displays the MIB Instance for an application 
parameter 
Can set it by typing in the MIB Set Value 
field (See Set function). 

MIB Values GUI window Displays the output 
of the query for a 
selected application 
within the 
Application, 
Program or Process 
Level. 

Displays the MIB Values for an application. 
To understand what these application 
parameters mean, refer to the Help menu 
or highlight the application parameter 
inside the MIB Values and click on the 
Describe button. 

4.1.9.2.1 The Describe MIB Variable Pop-up 

The Describe button on the ECS MIB Browser main screen displays the Describe MIB Variable 
Pop-up shown below. This display only pop-up provides the full description of the MIB Variable 
shown in the MIB Object ID of the main screen. 

4.1.9-8 609-CD-003-004




Figure 4.1.9-4. Describe MIB Variable Pop-up 

For a description of the ECS MIB Variable Pop-up, see Table 4.1.9-4 below. 
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Table 4.1.9-4. Describe MIB Variable Field Descriptions 
Describe MIB 

Browser Pop-up 
GUI Description 

Name or IP Address GUI window 
(display only) 

Internet Protocol address of the host that is running. 

Object ID GUI window 
(display only) 

Unique ID of the MIB variable used for storing and 
accessing the value 

Type GUI window 
(display only) 

The SNMP protocol uses a subset of ASN.1 (Abstract 
Syntax Notation One) to define the structure of data in a 
protocol data unit (PDU). SNMP uses the simple abstract 
data type to define the information content of the PDU 
which is the packet that is exchanged between an SNMP 
manager and its agents. The data type can be one of the 
following: 
Boolean TRUE or FALSE 
Integer The set of whole numbers 
Bit String A sequence of 0 or more bits 
Octet String A sequence of 0 or more octets 
Real The set of real numbers 
Enumerated An explicit list of integer values that a data type 
can take. 
Most often the type field in the MIB Browser will be either 
Integer or Octet String. 

Description GUI window 
(display only) 

Text description of the MIB variable 

4.1.9.2.2 HP OPenView Graph Pop-up 

The Graph option of the MIB Browser is performed by HP OpenView. See Section 4.2.1.2.2 for 
more information about the Graph option. 
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Figure 4.1.9-5. Graph Pop-up 

For a description of the Graph Pop-up, see Table 4.1.9-5 below. 

Table 4.1.9-5. Graph Field Descriptions 
Graph GUI Description 

Variables GUI window 
(display only) 

MIB variable are color coded as shown by the color of the 
variable IDs in the top portion of the Pop-up 

Horizontal Axis GUI window 
(display only) 

The selected time period 

Vertical Axis GUI window 
(display only) 

The numeric value of the MIB variable at the measuring 
point reflected in the horizontal axis. 

4.1.9.3 Required Operating Environment 

MIB Browser requires Open View running in the UNIX environment. The ECS MIB Browser 
GUI is only accessible from within the Open View. 
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For information on the operating environment, tunable parameters and environment variables of 
MIB Browser refer to the 920-TDx-013 “Custom Code Configuration Parameters” documentation 
series . The “x” refers to the installed location, e.g. 920-TDG-013 is for GSFC DAAC. 

4.1.9.3.1 Interfaces and Data Types 

This Tool exchanges data of various types through interfaces within and external to ECS. Table 
4.1.9-6 lists interfaces for Release 4. The MIB Browser utilizes two protocols for accessing the 
MIB. To Get variables (for monitoring performance parameters), it uses Simple Network 
Management Protocol (SNMP), and to Set variables (e.g., thresholds), it uses Distributed 
Computing Environment (DCE) Protocol. 

Table 4.1.9-6. Interface Protocols 
Interface Type of Primary 

Interface 
Protocols 

Type of Backup 
Interface 
Protocols 

Comments 

SNMP Inter-computer N/A Used to Get variables 

DCE intra-system N/A Used to Set variables 

4.1.9.4 Databases 

No database is associated with or used by the ECS MIB Browser. The ECS MIB Browser reads 
and compiles the ECS MIB located in the /var/opt/ov/share/snmp-mibs subdirectory on the 
HP Open View platform. This MIB is used to query the ECS hosts for data about the ECS 
applications at each host. The query identifies the data Types (see Table 4.1.9-4) to be returned 
from the host. The data values for the MIB objects are collected dynamically from the hosts by the 
agents/subagents in response to a query. The agents/subagents determine the location of the data 
values from the query and package the response based on the data Types. 

4.1.9.5 Special Constraints 

Necessary setup required to access information on any ECS Host, using ECS MIB Browser GUI: 

1. HP OpenView must be running. 

2.	 A Master Agent should be running in the background (e.g., EcMsAgAgent), and should be 
linked to ECS MIB Browser within the Open View through SNMP, and to associated 
configuration files and the Sub-Agent. 

3.	 A Sub-Agent must be running in the background (e.g., EcMsAgSubAgent ), and should be 
linked to Master Agent and supported ECS Applications (Apps). 

4.	 A Deputy Agent should be running in the background (e.g., EcMsAgDeputy), which will 
direct Remote Procedure Calls (RPC) from the sub-agent to the ECS MIB Browser, using 
the SNMP. 
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5. ECS application(s) must be running, in order to collect information. 

The proper community string must be entered in the community text field of the ECS MIB Browser 
GUI. This is the token or password that permits the operator to gather data from the ECS host. 
Different community values can be used to obtain privileges to all or part of the MIB. Operators 
must obtain the proper community string from the System Administration personnel. 

4.1.9.6 Outputs 

Outputs consist of the information displayed on the screens discussed in Section 4.1.9.2 and

messages from stout and stderr which are redirected to the log file found in the

/usr/ecs/shared/custom/logs subdirectory.


4.1.9.7 Event and Error Messages


Error messages are sent to stderr and redirected to the log file described in Section 4.1.9.6.


4.1.9.8 Reports 

None. 
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4.1.10 Mode Manager 

The Mode Manager is the tool for controlling the Mode Management Service (MMS), a custom 
developed ECS service which is tightly integrated with HP OpenView (see section 4.2.1, HP 
OpenView). It allows for the configuration of ECS applications in one operational mode and a 
variety of support modes in the training and test area. The MMS incorporates the mode 
management user interface directly into the HP OpenView GUI, providing methods to activate and 
deactivate a mode. In addition, it provides a mode specific user interface for accessing CSS life
cycle control (startup and shutdown). Monitoring capabilities are provided within HP OpenView 
and are enhanced to reflect mode specific status of software system, subsystem, application, 
program, and process level entities. Hardware is mode independent so its status is reflected within 
every mode in which it is configured. HP OpenView graphically supports multiple modes through 
the use of separate sub-maps and symbol labels. The map can have any number of sub-maps 
defined that decompose the basic high level map representation. Each mode has its mode specific 
map (and associated sub-maps) predefined to recognize and support the hardware and software 
components that are supporting the given mode. 

Table 4.1.10-1 summarizes the operator functions that the Mode Management Service supports. 

Table 4.1.10-1. Common ECS Operator Functions Performed with the 
Mode Management Service 

Operating 
Function 

Command Description When and Why to Use 

Add an Active 
Mode 

Add Adds a mode in the 
display of Available 
Modes to the Active 
Mode display and List 

When a previously not active mode is 
to be activated. 

Remove an active 
mode 

Remove Removes a mode in 
the Active Mode 
Display and List and 
restores it to the 
Available Mode 
display and List. 

When a mode is to be made inactive. 

Insert a new mode Insert Active Mode Puts a new mode in 
the Active Mode 
Display. 

When it is necessary to create a new 
active mode. 

Activate new 
mode 

Rediscover Shortcuts the 
subagent rediscovery 
process and forces 
the new mode into 
service across the 
network. 

When a new mode is placed in 
service and must be activated on all 
hosts. 

Update the 
Available Modes 
List 

Refresh Forces an update to 
the Available Modes 
List. 

When all the hosts have to be made 
aware of a new mode. 
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4.1.10.1 Quick Start Using Mode Management Service 

Mode Manager is started as part of the system start-up. It may be started from HP Openview (See 
Section 4.1.10.1.3 below). The Mode Manager operator interface consists of a single Main 
screen, the (ECS Mode Manager) and a confirmation dialog (pop-up). The ECS Mode Manager 
Main Screen is run on each ECS machine that has ECS Modes applied. 

4.1.10.1.1 Invoking Mode Management Service From the Command Line 
Interface 

The ECS Mode Management Service can not be invoked from the command line. The ECS Mode 
Manager is activated from HP Open View as described in the Section 4.1.10.1.3. 

4.1.10.1.2 Invoking Mode Management Service From the ECS Desktop. 

There is no icon on the ECS Desktop for Mode Management Service. Currently, the Mode 
Management Service is activated as described in Section 4.1.10.1.3. 

4.1.10.1.3 Invoking Mode Management Service From Open View 

In the Open View Main Screen, select Misc from the Desktop bar and choose ECS Mode Manager 
from the displayed menu. 

Figure 4.1.10.-1. HP OpenView Main screen showing Desktop bar 
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4.1.10.2 The ECS Mode Management Service Main screen 

Figure 4.1.10-2 below presents the ECS Mode Manager Main screen. 

Figure 4.1.10-2. ECS Mode Manager Main Screen 

For a description of the Mode Management Service Toolbar, see Table 4.1.10-2 below. 
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Table 4.1.10-2. Mode Management Service Main Screen 
Options and Fields 

Option/Field Action Description 

File menu Click on File on the Mode 
Manager Main screen Toolbar. 

Pull down menu showing Save As and Close 
selections. 

Save As In the File menu, click on Save 
As. 

To save results of ECS Mode Manager in any 
file or directory. 

Close In the File menu, click on 
Close. 

To exit the ECS Mode Manager. 

Help menu Click on Help on the Mode 
Manager Main Screen 
Toolbar. 

Describes a specific object or an application 
parameter, and explains its functionality. 

AVAILABLE MODE field List of the available modes 
from the Available Mode List. 

The Available Mode List and Active Mode List 
are supplied by the Network Management 
Platform 

ADD button Adds one or more modes 
from the Available Mode List 
to the Active Mode List. 

Select (highlight) the mode(s) to be entered 
into service before clicking the Add button. 

ACTIVE MODES field List of the active modes from 
the Active Mode List. 

The Available Mode List and Active Mode List 
are supplied by the Network Management 
Platform 

REMOVE button Removes a mode(s) from the 
Active Mode List. 

Select (highlight) the mode(s) to be entered 
into service before clicking the Remove 
button. The selected modes are moved to 
the AVAILABLE MODE pool. 

INSERT ACTIVE MODE 
field 

Manually put a new mode into 
service 

When an available mode is not discovered. 

REDISCOVER button Alerts all ECS hosts 
subagents that a new mode is 
entered into service. 

Forces all ECS subagents to check for a new 
mode. 

REFRESH button Update the available modes 
list. 

Forces an update of the mode label in the 
available modes list. This shortcuts the 
subagent discovery process which would 
normally provide automatic update of the list. 

CLOSE button Terminate the Mode Manager 
session. 

A dialog box (see section 4.1.1.2.1) will ask 
for confirmation from the user. 

4.1.10.2.1 The Mode Manager Question Dialog 

The Mode Manager Question Dialog is displayed in response to the Close button on the Mode 
Manager Main screen. This dialog verifies that the operator intends to Close (exit) the Main 
screen. 
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Figure 4.1.10-3. Mode Manager Question Dialog 

For a description of the ECS Mode Manager Question Dialog, see Table 4.1.10-3 below. 

Table 4.1.10-3. Mode Manager Question Dialog Field Descriptions 
Option/Field Action Description 

CLOSE button Click on button Confirm that the Mode Manager Main screen is to be 
CLOSEd. 

CANCEL button Click on button Cancel the effect of the CLOSE button on the Mode 
Manager Main screen. 

4.1.10.3 Required Operating Environment 

Mode Management Service requires Open View running in the UNIX environment.. 

For information on the operating environment, tunable parameters and environment variables of 
Mode Management Service refer to the 920-TDx-013 “Custom Code Configuration Parameters” 
documentation series . The “x” refers to the installed location, e.g. 920-TDG-013 is for GSFC 
DAAC. 

4.1.10.3.1 Interfaces and Data Types 

This Tool exchanges data of various types through interfaces within and external to ECS. Table 
4.1.10-4 lists interfaces for Release 4. The Mode Management Service utilizes two protocols for 
communicating with HP OpenView. To Get variables (for monitoring performance parameters), 
it uses Simple Network Management Protocol (SNMP), and to Set variables (e.g., thresholds), it 
uses Distributed Computing Environment (DCE) Protocol. 
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Table 4.1.10-4. Interface Protocols 
Interface Type of Primary Interface 

Protocols 
Comments 

SNMP Inter-computer Used to Get variables 

DCE intra-system Used to Set variables 

4.1.10.4 Databases 

No database is associated with or used by the ECS Mode Management Service. The Active and 
Available Modes Lists are library files used by the Mode Manager GUI. 

4.1.10.5 Special Constraints 

Necessary setup required to access information on any ECS Host, using ECS Mode Manager GUI: 

1. HP OpenView must be running. 

2.	 A Master Agent should be running in the background (e.g., MsAgAgent), and should be 
linked to ECS Mode Management Service within the Open View through SNMP, and to 
associated configuration files and the Sub-Agent. 

3.	 A Sub-Agent must be running in the background (e.g., MsAgSubAgent ), and should be 
linked to Master Agent and supported ECS Applications (Apps). 

4.	 A Deputy Agent should be running in the background (e.g., MsAgDeputy), which will 
direct Remote Procedure Calls (RPC) from the sub-agent to the ECS Mode Management 
Service, using the SNMP. 

5. ECS application(s) must be running, in order to collect information. 

The proper community string must be entered in the community text filed of the ECS Mode 
Manager GUI. This is the token or password that permits the operator to gather data from the ECS 
host. Different community values can be used to obtain privileges to all or part of the Mode 
Management Service. Operators must obtain the proper community string from the System 
Administration personnel. 

The Network Management Platform will export the Modes List subdirectory to the /tools/CMS 
mount point. All ECS hosts will mount /tools/CMS to access the single copy of the Active and 
Available Mode Lists. 

4.1.10.6 Outputs 

Outputs consist of the information displayed on the screens discussed in Section 4.1.10.2 and 
messages to stout and stderr. 

4.1.10.7 Event and Error Messages 

Error messages are sent to stout and stderr. 

4.1.10-6 609-CD-003-004




4.1.10.8 Reports 

None. 
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4.1.11 ECSAssist 

The ECS Assistant (ECSAssist) is a Custom program which simplifies the process of installation, 
testing and management of ECS. This utility is basically an installation tool which has practical 
application in the operations environment. The tool is for use in installing software and 
maintaining the information related to that software. Only the Subsystem Manager function of 
ECSAssist should be used in the ECS operational environment. 

Table 4.1.11-1 summarizes the functions that ECSAssist supports. 

Table 4.1.11-1. Common Tasks Performed with ECSAssist 
Task Description When and Why to Use 

Subsystem 
Manager actions 

Selections on the Subsystem 
Manager’s screen, see section 
4.1.11.2.1 

Installing software and performing 
maintenance on software parameters. 

Cleanup Removes CDS entries. When it is necessary to remove a CDS 
entry 

Database Used to install, drop, patch, update 
subsystem specific databases. 

When database updates or upgrades 
are implemented. See section 
4.1.11.2.1.1 .and 4.1.11.2.1.1.1 . 

Install Used to install ECS custom software 
into the selected mode. 

As necessary to install software. . See 
section 4.1.11.2.1.2 . 

Kill Kills Remove the programs selected in the 
Component, Application, and 
Executables fields. 

Mkcdsentry Makes CDS entries for servers within 
the selected component. 

As necessary to provide CDS entries. . 
See section 4.1.11.2.1.3 . 

Mkcfg Creates CFG, ACFG and PCFG files 
for selected components. 

When installing or updating software 
components. . See section 
4.1.11.2.1.4 . 

Monitor Monitors any server activity. As desired for monitoring. See section 
4.1.11.2.1.5 . 

Package Not available in Version 2.0. 

Stageinstall Used to capture the location of the 
delivered software staging area. 

A desired to identify a staging area. See 
section 4.1.11.2.1.6 . 

Start Used to start servers within the 
selected component. 

When HP OpenView is not available to 
perform this action.. 

Viewlog Used to view server log files. As desired to view log files. See section 
4.1.11.2.1.7 . 

Uninstall Not available in Version 2.0. 

ESDT Manager Not available in Version 2.0. 

Mode Manager Not available in Version 2.0. 
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4.1.11.1 Quick Start Using EcsAssist 

ECS Assist is a Custom software product for ECS. Its origin as a development tool provides 
“fallback” functionality for other tools, such as HP OpenView. 

4.1.11.1.1 Invoking EcsAssist From the Command Line Interface 

To execute ECSAssist from the command line prompt use: 

DISPLAY must be set to the current host. 

ECS_HOME must be set to /usr/ecs. 

TK_LIBRARY must be set to /tools/lib/tk4.2 

Mount point called /tools must be mounted. 

File /tools/common/ea must exist in the path. (This can be set in the .cshrc or .kshrc 
file) 

EA or, if this alias is not available, EcCoAssist 

If the machine on which the current item to be installed is a SUN, prior to starting ECS Assistant, 
copy the file EcSysCfgEnvCsh from directory /ecs to directory /usr/ecs/local. Resource the 
.cshrc file. root authority may be necessary to perform this copy operation. 

A screen labeled "Thanks for choosing ECS Assistant" will appear for 5 seconds. 

4.1.11.1.2 Invoking ECSAssist From the ECS Desk top. 

There is no icon on the ECS Desktop for ECSAssist. Currently, the ECSAssist GUI is activated 
with a command line script as described in the previous section. 

4.1.11.2 ECSAssist Main Screen 

The ECSAssist Main Screen identifies the user (operator) and host machine. From the ECSAssist 
Main Screen the operator may select the ECSAssist functions described in Table 4.1.11-2 below. 
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Figure 4.1.11.-1. ECSAssist Main Screen. 

Table 4.1.11-2 below summarizes the menus and options available on the ECSAssist Main Screen. 
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Table 4.1.11-2. ECSAssist Options and Field Descriptions 
Task Description When and Why to Use 

File 

View Task Output 
file 

In the File menu, click View Task 
Output File. 

Allows users to view and/or print the 
results of any executed tasks. 

Preferences In the file menu, click Preferences. Allows users to select preferences. 

Exit Terminate use of tool To Quit tool 

Help Click on Help on the Subsystem 
Manager Screen Toolbar. 

Pulls down menu showing “Contents”, 
“Read Me” and “About” selections. 

User: Host: 
(labels) 

Provides labels for the field to the 
right. 

Display only 

User: Host: 
(display) 

Displays the current host and user. Automatically displayed. 

Subsystem 
Manager 

Perform software installation and 
maintenance functions. 

See Section 4.1.11.2.1 

ESDT Manager Not available in Version 2.0. 

Mode Manager Not available in Version 2.0 

4.1.11.2.1 The ECSAssist Subsystem Manager screen


In the ECSAssist Main Screen select Subsystem Manager.


Figure 4.1.11-2 below presents the ECSAssist Subsystem Manager screen.
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Figure 4.1.11-2. Subsystem Manager Screen 
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For a description of the Subsystem Manager Toolbar, see Table 4.1.11-3 below. 

Table 4.1.11-3. ECSAssist Subsystem Manager Toolbar (1 of 2) 
Option/Field Action Description 

File Click on File on the 
Subsystem Manager screen 
Toolbar. 

Pull down menu showing Save As and Close 
selections. 

Mode Manager In the File menu, click on Save 
As. 

To save results of ECS Mode Manager in any 
file or directory. 

ESDT Manager In the File menu, click on 
ESDT Manager. 

Used to configure(copy) descriptor files and 
associated shared objects to the proper 
location. 

View Task Output File In the File menu, click View 
Task Output File. 

Allows users to view and/or print the results of 
any executed tasks. 

Remove Task Output 
File 

In the File menu, click 
Remove Task output File. 

Allows users to remove the file containing 
installation specific results. 

Preferences In the file menu, click 
Preferences. 

Allows users to select preferences. 

Exit In the file menu, click Exit. Exits Subsystem Manager. 

Tools 

Browse Directories In the Tools menu, click 
Browse Directories. 

Allows users to locate files and display or print. 

Clean Logs In the Tools menu, click Clean 
logs. 

Allows users to remove outdated log files. 

Playback Commands Not available in Version 2.0. 

Refresh In the Tools menu, click 
Refresh. 

Allows users to copy control files in the 
selected mode. 

Retrofit In the Tools menu. Click on 
Retrofit. 

Re-copies script, binary, libraries and control 
files into the selected mode. 

System Messages In the Tools menu. Click on 
“System Messages”. 

Displays system messages, from /var/adm. 

Re-Read .sitemap file In the Tools menu. Click on 
“Re-read .sitemap file”. 

If there is a change to the .sitemap file, this 
function re-reads to obtain the latest 
information. 

Options Not available in Version 2.0. 

Feedback Not available in Version 2.0. 
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Table 4.1.11-3. ECSAssist Subsystem Manager Toolbar (2 of 2) 
Option/Field Action Description 

Latest Info Click on Latest Info button Displays new updates, if any, for ECSAssist. 

Extensions Click on extensions button Pulls down menu showing a list of subsystem 
specific executables used for supporting 
tasks. 

Help Menu Click on Help on the 
Subsystem Manager Screen 
Toolbar. 

Pulls down menu showing “Contents”, “Read 
Me” and “About” selections. 

Common Tasks 

Cleanup Click on cleanup button Removes CDS entries. 

Database Click on database button Used to install, drop, patch, update 
subsystem specific databases. 

Install Click on install button Used to install ECS custom software into the 
selected mode. 

Kill Click on kill button Kills 

Mkcdsentry Click on mkcdsentry button Makes CDS entries for servers within the 
selected component. 

Mkcfg Click on mkcfg button Creates CFG, ACFG and PCFG files for 
selected components. 

Monitor Click on monitor button Monitors any server activity. 

Package Not available in Version 2.0. 

Stageinstall Click on stageinstall button Used to capture the location of the staging 
area. 

Start Click on start button Used to start servers within the selected 
component. 

Viewlog Click on viewlog button Used to view server log files. 

Uninstall Not available in Version 2.0. 

For a description of the Subsystem Manager Field Descriptions, see Table 4.1.11-4 below. 
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Table 4.1.11-4. ECS Assist Subsystem Manager Field Descriptions 
Option/Field Action Description 

Modes Click Select the mode. 

New Click Create a new mode. 

Refresh Click Refresh the Mode display using the source of the 
Mode information. This is useful after a New mode. 

Subsystems Click Select the subsystem resulting in a list of available 
components in the “Component” field. 

Components Click Select the component resulting in a list of available 
application in the “Applications” field. 

Applications Click Select the application resulting in a list of available 
program in the “Executables” field. 

Executables Click Select the program displayed. 

Results Display only Displays the captured the results of executed tasks. 

Settings Display only Lists user’s current selections. 

Installation 
Statistics 

Display only List installation specific statistics. 

Installed 
Subsystems 

Display only Used as legend. When an install task has completed, a 
color of Yellow, Red or Green highlights the selected 
subsystem to denote the severity of the install. 

4.1.11.2.1.1 ECSAssist Subsystem Manager’s “database” screen 

This screen is used to install, drop, patch, update subsystem specific databases. From the 
ECSAssist Subsystem Manager screen click the database button to initiate the database process. 

Figure 4.1.11-3 below presents the database screen. 

Figure 4.1.11-3. Subsystem Manager “database” Screen 
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Table 4.1.11-5. ECS Assist Subsystem Manager’s “database” 
Field Descriptions 

Option/Field Action Description 

Database Config Screen Display only Title 

EcDsSrDbBuild Display only Component passed from the Subsystem Manager 
screen 

SQSSERVER Entry Configurable item for the displayed Component 

GROUPNAME Entry Configurable item for the displayed Component 

ENVIRONMENT Entry Configurable item for the displayed Component 

O K  Click Displays the database script screen 

Cancel Click Aborts process 

4.1.11.2.1.1.1 ECSAssist Subsystem Manager’s “database script” 
screen 

This screen is triggered from the ECSAssist Subsystem Manager’s “database” screen, section 
4.1.11.2.1.1 above. The screen is used to input the parameters to set up the database. In the 
ECSAssist Subsystem Manager’s database script screen, the operator must enter all parameters to 
initiate the respective database script. 

Figure 4.1.11-4 below presents the database screen. 

Figure 4.1.11-4. Subsystem Manager “database script” Screen 

4.1.11-9 609-CD-003-004




Table 4.1.11-6. ECS Assist Subsystem Manager’s “database script” 
Field Descriptions 

Option/Field Action Description 

Database Script 
Parameters 

Display only Title 

EcDsSrDbBuild Display only Title 

Mode Display only Displays selected mode. 

DBO ID Entry Enter dbo id 

Password Entry Enter password 

SQL Server Name Entry Enter sql server name 

Database Name Entry Enter database name 

O K  Click Initiates process 

Cancel Click Aborts process 

4.1.11.2.1.2 ECSAssist Subsystem Manager’s Install screen 

This screen is used to install ECS custom software into the selected mode. From the ECSAssist 
Subsystem Manager screen click the install button to initiate the installation process. 

Figure 4.1.11-5 below presents the Install screen. 

Figure 4.1.11-5. Subsystem Manager Install Screen 
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Table 4.1.11-7. ECS Assist Subsystem Manager Install 
Field Descriptions 

Option/Field Action Description 

Installation Type Display only Heading. 

Development Click Creates symbolic links to ClearCase. 

Normal Click Copies binaries and libraries to selected mode. 

Staging Area Click Installs Mode from staging area. 

Source File 
Location 

Display only Heading. 

Stage Click To obtain files from the nightly build. 

Non Stage Click Allows testing of changes before a merge to branch is 
performed. 

Standard Click Default setting. Used to list available packages. 

Custom Click Not available in Release 4. 

Packages Display only Heading. 

O k  Click Executes installation process. 

Cancel Click Aborts Installation process. 

4.1.11.2.1.3 ECSAssist Subsystem Manager “mkcdsentry” screen 

This screen makes CDS entries for servers within the selected component.. From the ECSAssist 
Subsystem Manager screen click the mkcdsentry button to initiate the configuration process. 

Figure 4.1.11-6. below presents the mkcdsentry screen. 

Figure 4.1.11-6. Subsystem Manager “mkcdsentry” Screen 

Table 4.1.11-8. ECS Assist Subsystem Manager mkcdsentry Field 
Descriptions 

Option/Field Action Description 

DCE Cell Admin Password Display only 

Password Entry Enter Cell Admin Password. Has to be entered by 
DCE cell administrator. 

O k  Click Creates keytab files to be used by DCE. 

Cancel Click Aborts CDS entry process. 

4.1.11-11 609-CD-003-004




4.1.11.2.1.4 ECSAssist Subsystem Manager’s “mkcfg” screen 

This screen creates CFG, ACFG and PCFG files for selected components. From the ECSAssist 
Subsystem Manager screen click the mkcfg button to initiate the configuration process. 

Figure 4.1.11-7 below presents the mkcfg screen. 

Figure 4.1.11-7. Subsystem Manager “mkcfg” Screen 

Table 4.1.11-9. ECS Assist Subsystem Manager mkcfg 
Field Descriptions 

Option/Field Action Description 

Configurable Parameters Display only 

EcDsHdfEosServer Click Allows operator to configure EcDsHdfEosServer. 

EcDsScienceDataServerCli 
e n t  

Click Allows operator to configure 
EcDsScienceDataServerClient. 

EcDsScienceDataServer Click Allows operator to configure 
EcDsScienceDataServer  . 

EcDsSdSrvGui Click Allows operator to configure EcDsSdSrvGui. 

EcDsSdSrvGuiMkcfg Display only 

DSServerUR Enter Operator enters specific data to DSServerUR 

O k  Click Executes configuration process. 

Cancel Click Aborts configuration process. 

Print Click Prints configuration parameters. 

4.1.11.2.1.5 ECSAssist Subsystem Manager’s “monitor” screen 

This screen monitors any server activity. From the ECSAssist Subsystem Manager screen click 
the monitor button to initiate the monitor process. 
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Figure 4.1.11-8 below presents the monitor screen. 

Figure 4.1.11-8. Subsystem Manager “monitor” Screen 
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Table 4.1.11-10. ECS Assist Subsystem Manager’s monitor Field 
Descriptions 

Option/Field Action Description 

ECS Monitor Display only Title 

Mode Display only Displays the current mode. 

Subsystem Display only Displays the selected subsystem. 

Component Display only Displays the selected component. 

Hostname Display only Displays the hostname. 

User Id Display only Displays the user’s id. 

Date Display only Displays the date. 

Exit Click Exits monitoring process. 

Update Now Click Refreshes the monitor screen. 

Cdsping all servers… Click Display a list of server processes and their statuses. 

Auto Update Toggle When set to on, the monitor will refresh itself. 

4.1.11.2.1.6 ECSAssist Subsystem Manager’s “stage install” screen 

The stage install screen is used to input the staging location where the delivered software is stored. 
From the ECSAssist Subsystem Manager screen click the stageinstall button to initiate the viewlog 
process 

Figure 4.1.11-9 below present the stage install screen. 

Figure 4.1.11-9. Subsystem Manager “stageinstall” Screen 

Table 4.1.11-11. ECS Assist Subsystem Manager stageinstall Field 
Descriptions 

Option/Field Action Description 

Stage Display only Title 

Provide staging area 
source location 

Display only Label 

Input field Input Type in the staging area filename 

O k  Click Accepts the operator’s entry 

Cancel Click Aborts the process 
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4.1.11.2.1.7 ECSAssist Subsystem Manager’s “viewlog” screen 

This screen is used to view server log files. From the ECSAssist Subsystem Manager screen click 
the viewlog button to initiate the viewlog process. 

Figure 4.1.11-10 below presents the viewlog screen. 

Figure 4.1.11-10. Subsystem Manager “viewlog” Screen 

Table 4.1.11-12. ECS Assist Subsystem Manager’s viewlog Field 
Descriptions 

Option/Field Action Description 

Log Viewer Display only Title 

File Display only Displays the current mode. 

Quit Display only Displays the selected subsystem. 

Components Display only Displays the selected component. 

D M  Display only Subsystem DM. Select this entry to view logs for the 
subsystem DM. 

D S S  Display only Subsystem DSS. Select this entry to view logs for the 
subsystem DSS.. 

INGEST Display only Subsystem INGEST. Select this entry to view logs for 
the subsystem INGEST. 

4.1.11.2.2 ECSAssist ESDT Manager 

Not available in Version 2.0. 

4.1.11.2.3 ECSAssist Mode Manager 

Not available in Version 2.0. 

4.1.11.3 Required Operating Environment 

For information on the operating environment, tunable parameters and environment variables of 
ECSAssist refer to the 920-TDx-013 “Custom Code Configuration Parameters” documentation 
series . The “x” refers to the installed location, e.g. 920-TDG-013 is for GSFC DAAC. 

4.1.11-15 609-CD-003-004




4.1.11.3.1 Interfaces and Data Types 

None. 

4.1.11.4 Databases 

No database is associated with or used by the ECSAssist. ECSAssist may create entries in the 
CDS catalog, create configuration files for software components, remove outdated log files, or 
update other files related to the functions performed. 

4.1.11.5 Special Constraints 

None. 

4.1.11.6 Outputs 

Output from the ECSAssist tool consists of the data displayed on the GUIs described in 
Section 4.1.11.2.n and error and event messages described in Section 4.1.11.7 

4.1.11.7 Event and Error Messages 

Event and Error Messages for ECSAssist are listed in Appendix A. All outputs associated with 
ECS Assistant are captured in a file call /tmp/<userid>.ecs_session.log. 

4.1.11.8 Reports 

None. 
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4.2 System Monitoring 

This section describes the system monitoring tools used by DAAC operators: 

• HP OpenView 

• Tivoli 

• Remedy 

• PEER/Patrol SNMP 
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4.2.1 HP OpenView 

This section describes how HP OpenView is used by DAAC Operators to perform system 
monitoring. HP OpenView provides operators to specify, for each managed object, the following 
information: 

•	 Performance attributes to be collected. Management Information Bases (MIBs) are used to 
define attributes that can be collected from various managed objects. Each performance 
attribute that can be measured has an associated object identifier (oid) specified in a MIB. 
HP OpenView collects data for each oid that has been specified for a particular managed 
object. 

•	 Frequency of performance attribute data collection. This value can be set differently for 
each attribute associated with a managed object. 

•	 Threshold(s) which indicate degraded performance condition(s) (one or more can be set for 
each oid on each managed object). For each threshold set, a corresponding rearm value 
can also be set. Once the threshold is exceeded, the performance attribute must then fall 
below the rearm value before the performance degradation is cleared. This prevents the 
generation of multiple degradation alerts in the case where the performance attribute value is 
fluctuating around the threshold value. 

•	 Performance attributes to be logged. HP OpenView logs only that data specified by the 
operator. For each oid on each managed object, performance management can take one of 
three forms: 

1. attribute not monitored 

2. attribute monitored but not logged 

3. attribute monitored and logged 

HP OpenView can monitor any performance management attributes that are included in MIBs and 
supported by ECS management agents. 

HP OpenView is used to perform Network Management functions described in the vendor manual 
HP OpenView Using Network Node Manager. The common ECS specific OpenView functions 
used by the DAAC operators are listed in Table 4.2.1-1. 
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Table 4.2.1-1. Common ECS Operator Functions Performed withÄ
HP OpenViewÄ

Operating 
Function 

Command/Script Description When and Why to Use 

Start application 
program 

Start Executable 
on GUI 

Starts the selected (wheat 
or red colored icon) ECS 
application program. 

To manually start ECS 
applications programs 

End application 
programs 

Shutdown 
Executable on GUI 

Right mouse button kills 
the selected (green 
colored icon) 

To manually terminate a 
running ECS applications 
program. 

4.2.1.1 Quick Start Using HP OpenView 

HP OpenView is a COTS product used to manage the ECS system. The OpenView GUI provides 
a display of the status for managed objects, selection of system monitoring functions, and operator 
input for system management. For more information please see Chapter 2 “Getting Started” in the 
“Using Network Node Manager” manual. 

The documentation of HP OpenView used as a basis and referenced in this section is for 
Version 4.11 

4.2.1.1.1 Invoking HP OpenView From the Command Line Interface 

To execute HP OpenView the operator must be logged onto the OpenView host. 

To execute OpenView from the command line prompt use: 

setenv DISPLAY {machine name}:0 

setenv SHLIB_PATH /opt/OV/lib:${SHLIB_PATH} 

/opt/OV/bin/ovw [-map mapname]& 

Where mapname is the name of the OpenView map for ECS Application Management. 

If it is necessary to execute MSS Agents from the command line prompt use: 

/usr/ecs/SHARED/CUSTOM/utilities/ECMSAgentStart 

Refer to the 920-TDx-013 “Custom Code Configuration Parameters” documentation series , for a 
listing of the ovw 

4.2.1.1.2 Invoking HP OpenView From the ECS Desk top. 

To invoke the tool, click on the HP OpenView GUI icon from the ECS Desktop. 
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Figure 4.2.1-1. HP OpenView GUI Icon (on ECS Desktop) 

If the icon is not available, invoke HP OpenView with the command line script described in 
Section 4.1.12.1.1.1, HP OpenView (Startup and Shutdown). 

4.2.1.2 HPOV Main Screen 

The main screen shows the DAAC site with Network and Services icons. The Network icon 
provides the status of SNMP supported devices. The Service icon monitors the status of the ECS 
application. Under the menu bar are Navigation icons. 

From left to right the Navigation icons are: 

•	 Close - Close this submap. If this is the last submap open, OpenView displays a 
confirmation dialog before exiting. 

• Home - Go to the home submap for the this users. 

• Root - Go to the root submap for this map. 

• Parent - Go to the parent submap for this submap. 

• Quick Navigation - Go to the submap which can be customized by the operator. 

• Zoom - Zoom in on a portion of the map. 

• Help - Provides on-line help. 

The pull-down menu bar is also part of OpenView. For more information about these functions 
please see Chapter 2 “Getting Started” in the “Using Network Node Manager” manual. 

4.2.1-3 609-CD-003-004




Figure 4.2.1-2. HP OpenView Main Screen showingÄ
geographic distribution of Network NodesÄ
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Figure 4.2.1-3. HP OpenView Main Screen showing OV map with 
examples of managed object icons 

The icons displayed on the OpenView map identify the ECS servers. These icons are described in 
Table 4.2.1-2 below. 
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Table 4.2.1-2. HPOV Service example icon DescriptionsÄ
Symbol Description 

MSS Management Subsystem Server 

IDG Infrastructure Development Group Server 

DPS Data Processing Subsystem Server 

PLS Planning Subsystem Server 

SDSRV Science Data Server 

CLS Client Subsystem Server 

IOS Advertising Subsystem Server 

DMS Data Management Subsystem Server 

DDICT Data Dictionary Subsystem Server 

DDIST Data Distribution Subsystem Server 

STMGT Storage Management Subsystem Server 

INS Ingest Subsystem Server 

4.2.1.2.1 Event Categories 

The Event Categories Pop-up (Figure 4.2.1-4) provides selection of the events to be monitored. 
The list of selectable events is configurable and is dependent on the collection of managed objects 
and the data collection agents. 

Figure 4.2.1-4. HP OpenView Event Categories Pop-up 
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Table 4.2.1-3. Event Categories Selection Fields DescriptionÄ
Field Name Description 

Error Events Events that indicate that inconsistent or unexpected behavior 
occurred 

Threshold Events Events that indicate a threshold was exceeded 

Status Events Events that indicate the status of a component or interface has 
changed 

Configuration Events Events that indicate that a node’s configuration has changed 

Application Alert Events Events that describe the status of the system performance 
management software 

ECS Appl. Fault Event Events that indicate a fault has occurred. 

ECS Appl. Performance Event Events that indicate that a performance threshold was reached. 

ECS Appl. Status Event Events that indicate that a status has changed. 

ECS Security Event Events that indicate that a security issue has occurred. 

ECS Transaction Event Events that indicate that a transaction has occurred. 

All Events All events listed above 

4.2.1.2.2 OpenView Grapher 

Operators may display selected managed object parameters in graph form using the GRAPHER 
function. See Chapter 9 “Using the Grapher” in the “Using Network Node Manager” manual for 
more detail on this process. The information displayed by Grapher may be printed. 
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Figure 4.2.1-5. HP OpenView Graph Screen 

Table 4.2.1-4. HP OpenView Grapher Field Description 
Field Name Description 

Parameter Identification The part of the screen immediately above the graph displays the 
parameters graphed. If multiple parameters are graphed, a color 
code is provided for recognition. 

Vertical Axis The vertical axis units are computed to fit the display area. 

Horizontal Axis The horizontal axis units are computed to fit the display area. 

4.2.1.3 Required Operating Environment 

HP OpenView requires HP-UX 10.X. 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
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document for each product. To find the documentation for HP OpenView, refer to the ECS 
Baseline Information System web page, URL: 

http://cmdm.east.hitc.com/. 

4.2.1.3.1 Interfaces and Data Types 

HP OpenView exchanges data of various types through interfaces within and external to ECS. 
Table 4.2.1-5 lists HP OpenView system interfaces. 

Table 4.2.1-5. External Interface Protocols 
Interface (facility) Type of Primary 

Interface 
Protocols 

Type of Backup 
Interface 
Protocols 

Comments 

EcMsAgDeputy SNMP None Receive events from 
subagent and forward 
them to OV via SNMP 

EcMsCmEcsd SNMP, HPOV API None Receive events from 
EcMsAgDeputy to 
update OV database. 

EcMsCmMgr SNMP, HPOV API None Use events sent by 
EcMsAgDeputy and 
Database info to 
update OV GUI map. 

4.2.1.4 Databases 

HP OpenView uses a proprietary database to store objects, topology, map, and event information. 

4.2.1.5 Special Constraints 

None. 

4.2.1.6 Outputs 

Output from the HP OpenView consists of the data displayed on the GUIs described in 
Section 4.2.1.2, database updates or additions to the database referenced in Section 4.2.1.4, error 
and event messages described in Section 4.2.1.7, and reports described in Section 4.2.1.8 which 
may produce files output in response to user actions or are printed. 

4.2.1.7 Event and Error Messages 

HP OpenView issues both status and error messages to the Event Browser Window. 
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4.2.1.8 Reports 

Data stored in the OpenView database will be sent to ECS Report Generation Service to generate 
ECS reports. This data may also be viewed and printed with the OpenView Graphing Utility. See 
Chapter 9 “Using the Grapher” in the “Using Network Node Manager” manual for more detail on 
this process. 
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4.2.2 Tivoli 

Tivoli is a COTS product serving as a network systems administration and performance/fault 
monitoring tool. It provides administration through the “profiles” of users, groups, and hosts. 
Tivoli also provides monitoring of system fault and performance management. Tivoli is a package 
of several related components: Tivoli Management Platform, Tivoli Sentry, Tivoli Courier, and 
Tivoli Enterprise Console. Tivoli Management Platform provides the administrative and 
management services to support the package. Tivoli Sentry allows for customization of the events 
and thresholds to monitor. Once the events to monitor have been selected, the operator can 
determine which actions should be taken for each of the various thresholds. Using the Tivoli 
Enterprise Console (TEC), the operator can monitor events as they occur. Enterprise SQL Server 
Manager (ESSM) is used to provide for SQL Server administration and management. Tivoli is 
used to perform the operating functions listed in Table 4.2.2-1. 

Table 4.2.2-1. Common ECS Operating Functions Performed with Tivoli 
(1 of 2) 

Operating 
Function 

GUI Description When and Why to 
Use  

system 
administration 

Tivoli Admin • allows for the creation of an 
M&O “users” account from a 
single GUI interface including 
the creation of: 
− UNIX account 
− corresponding ECS DCE 

account 
− home directory 
− selection of 

corresponding roles 
− mail aliases 

• allows for the administration of 
a distributed heterogeneous 
Unix system. Manages the 
following resources: 
− Unix Host 
− NIS Maps 
− Host Namespace 
− Unix Users 
− Unix Groups 

• to create/modify/ delete 
“User” Accounts 

• to manage and 
distribute UNIX Users, 
UNIX Groups, and Host 
Namespace information 

• to distribute all of the 
information to all of the 
hosts with one single 
command 
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Table 4.2.2-1. Common ECS Operating Functions Performed with TivoliÄ
(2 of 2)Ä

Operating 
Function 

GUI Description When and Why to 
Use  

System 
Monitoring 

Tivoli Enterprise 
Console (TEC) 

• provides overall systems 
monitoring functionality 

• provides a single location to 
monitor all events that are 
occurring through the system 

• provides a gauge to determine 
the severity of each event 

• provides a log of each event 

to monitor the overall 
activities associated with 
ECS 

Performance 
and Fault 
Monitoring 

Tivoli/Sentry • provides a set of pre-canned 
monitors, as well as capability 
to develop unique monitors 

• allows selection of severity 
level (can set up unique 
monitors for 5 different levels), 
thresholds, and notice groups 

to add, delete, or modify 
the performance and fault 
monitors 

4.2.2.1 Quick Start Using Tivoli 

This section presents an orientation of Tivoli. The Tivoli Desktop presents an integrated desktop 
environment for the operators. From the desktop, the operator is able to access Tivoli functions 
directly (e.g., Enterprise Console, Sentry, ADMIN) and launch the other COTS (e.g., security 
management applications) from icons on the desktop. The Tivoli Desktop also provides a 
mechanism to limit each operator's view into the management toolset. The Tivoli Administrator 
sets up each operator's desktop and assigns operator privileges that limit what can be accessed 
based on the operator’s Tivoli role. Tivoli terminology addresses the different functions the tools 
perform. 

A Tivoli Administrator  (Tivoli Management Platform User’s Guide, Chapter 2) is a system 
administrator that has been established as a Tivoli Management Environment (TME) administrator. 
The initial Tivoli administrator is added during installation of the TME. Since root authority 
(role) is required to install the TME, the initial Tivoli administrator is called the root administrator 
by default. After the TME is installed, other non-root administrators can be defined and given 
roles in policy regions.  These administrators can perform assigned system management tasks 
without being root or requiring access to the super user password (super role). 

The Tivoli Management Environment (TME) uses policies  (Tivoli Management Platform User’s 
Guide, Chapter 5) to allow the system administrator to customize TME for system needs. A 
policy is a written rule that is put into effect for a system that the TME enforces as management 
operations are performed by administrators. If a Tivoli administrator has the senior role over a 
source or TMR, they can implement organization-specific administration rules to ensure that the 
management operations are only performed within the bounds of the organization’s rules and 
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procedures. A default policy is a set of default resource property values that are assigned to the 
resource when the resource is entered into Tivoli. A validation policy ensures that all resources 
in a policy region comply with the region’s established policy. 

A policy region (Tivoli Management Platform User’s Guide, Chapter 5) is a special collection of 
resources that share one or more common policies. Policy regions provide a way to model the 
management and organization model of the distributed computing environment. A managed 
resource is a specific instance of a resource type that has a default policy defined in the policy 
region. 

A Tivoli Management Region (TMR) (Tivoli Management Platform User’s Guide, Chapter 4) is a 
TME server and the set of clients that it serves. 

A profile  (Tivoli Management Platform User’s Guide, Chapter 6) is a set of common 
configuration information, for a group of machines used for similar purposes, in a centralized area. 

A notice  (Tivoli Management Platform User’s Guide, Chapter 7) is a message concerning some 
operation or change in the distributed system. Notices are generated by a Tivoli system 
management operation. 

The documentation of Tivoli used as a basis and referenced in this section is for version 3.0.1, 
contained in ECS Release 4. 

4.2.2.1.1 Invoking Tivoli From the Command Line Interface 

To execute Tivoli from the command line prompt use: 

source /etc/setup_env.csh (in c shell) 

. /etc/Tivoli/setup_env.sh (in Bourne or bash shell) 

tivoli -font fixed 

4.2.2.1.2 Invoking Tivoli From the ECS Desktop. 

To invoke Tivoli, click on the Tivoli icon from the ECS Desktop. 

Figure 4.2.2-1. Tivoli Icon (on ECS Desktop) 

If the icon on the ECS Desktop is not available, Tivoli can be started with the command line 
interface described in Section 4.2.2.1.1. 
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4.2.2.2 Tivoli Main Screen 

The Main screen is the TME Desktop for Administrator “User Name” Screen, shown in Figure 
4.2.2-2. From this screen, an operator has access to the Tivoli according to the role and privileges 
assigned. The screen is divided into two windows: an upper window containing icons of the 
available Tivoli functions, and a lower window that displays status messages pertaining to ongoing 
functions selected in the upper window. From this desktop, the Administrator has the following 
selections: 

• Administrators 

• Notices 

• Enterprise Console (in “test”) 

• Event Server 

• Admin Policy Region 

• GSFC Policy Region 

•	 “Server” Region Policy Region (Note: this is created during the Tivoli install. It only 
appears on the root users desktop and contains icons for all of the client/servers that were 
created during install.) 

• Scheduler 
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 Figure 4.2.2-2. TME Desktop for Administrator GUI 

4.2.2.2.1 Administrators GUI 

Clicking on the Administrators icon in the upper window of the TME Desktop for Administrator 
GUI (shown in Figure 4.2.2-2) opens the Administrators window. From this window, the 
operator can add and delete users and edit user roles (resource and TMR region), logins, and notice 
groups. For more information on the Administrators GUI, see Chapter 3: Tivoli 
Administrators of the Tivoli Management Platform User’s Guide. 
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4.2.2.2.2 Notices GUI 

Clicking on the Notices icon in the upper window of the TME Desktop for Administrator 
GUI(shown in Figure 4.2.2-2) invokes the Notices application, which is a notification facility that 
tracks system administration activity. The notifications inform Tivoli Administrators of systems 
management operations and report which administrator performed particular actions. The 
notification facility can serve as an Audit Trail to allow for later determination of “who did what” in 
the system. For more information on the Notification Facility, see Chapter 7: Notification of the 
Tivoli Management Platform User’s Guide. 

4.2.2.2.3 Tivoli Enterprise Console 

Clicking on the Enterprise Console icon in the upper window of the TME Desktop for 
Administrator GUI (shown as “test” in Figure 4.2.2-2) invokes the Enterprise Console. This 
application provides centralized processing and management of distributed events, allows shared or 
partitioned administrator responsibilities based on enterprise-defined areas of responsibility, and a 
flexible interface to view and respond to events based on events severity, source, location, or other 
characteristics. For more information, see the Tivoli/Enterprise Console User’s Guide. 

4.2.2.2.4 Tivoli Event Server 

Clicking on the EventServer icon in the upper window of the TME Desktop for Administrator 
GUI(shown in Figure 4.2.2-2) brings up the Event Server which provides a centralized location 
for the management of all configured events. The Event Server performs the following functions: 

• Logging 

• Applying rules 

• Correlating Events 

• Responding automatically to events 

• Updating event consoles 

• Processing input from event consoles 

• Delaying responses to events 

• Escalating events 

For more information, see pages 2-7 of the Tivoli/Enterprise Console User’s Guide. 

4.2.2.2.5 Tivoli Admin Policy Region 

Clicking on the Admin (Admin is the unique name provided by the developer) icon in the upper 
window of the TME Desktop for Administrator GUI( Figure 4.2.2-2), invokes the Tivoli Admin 
Policy Region which is a collection of User, Group, and Host management profiles. A Policy 
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Region is a special collection of resources that share one or more common policies. Policy Regions 
provide a way to model the management and organization model of the distributed computing 
environment. For more information on Policy Regions, see Chapter 5: Policy and Policy Regions 
of the Tivoli Management Platform User’s Guide. 

4.2.2.2.5.1 Tivoli Admin Profile Manager 

Subordinate to the Policy is a Profile Manager. The Profile Manager Icon. Profile Managers 
provide a way for profile managers to organize groups of profiles. They control the distribution of 
profiles to subscribers across a specified portion of a network. For more information on Profile 
Managers, see Chapter 6: Configuration Management of the Tivoli Management Platform User’s 
Guide. 

4.2.2.2.5.1.1 Tivoli Admin Profiles 

Beneath the Profile Managers are Profiles. Profiles are collections of application-specific 
information. Each Profile is specific to a particular profile type and each profile contains 
configuration information. In the case of the Tivoli Admin Profiles there are User, Group, and 
Host Profiles. User Profiles contain user account configuration information. Group Profiles 
contain group account information. For more information on Profiles, see Chapter 6: 
Configuration Management of the Tivoli Management Platform User’s Guide. For more 
information on User and Group Profiles, please see the Tivoli User and Group Management 
Guide. Host Profiles provide configuration information for hosts. For more information on Host 
Profiles, please see the Tivoli Host Management Guide. 

4.2.2.2.5.1.2 Tivoli User Profile Properties 

At this level there are three Tivoli Profiles: User, Group, and Host. If the User Group is opened, 
the User Profile Properties window appears (see Figure 4.2.2-3 below). To add a new user, select 
the “Add ” button in the bottom left corner of this window. This is the GUI that is used to create an 
ECS Account (both UNIX and DCE) for a new member of the M&O staff. The customized Add 
Record To Profile window appears. Added to this window have been the Home Telephone field 
(this is where the operator’s home telephone number appears), Available Roles (this is where the 
operator’s available roles are selected), DCE Group field (where the operator’s DCE Group is 
indicated), and the DCE Organization (where the operator’s DCE organization is indicated.) For 
more information on this window (standard features), please see Chapter 3: Using User Profiles of 
the Tivoli User and Group Management Guide. 
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Figure 4.2.2-3. Add Record to Profile ScreenÄ
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4.2.2.2.6 Tivoli GSFC Policy Region 

A Policy Region is a special collection of resources that share one or more common policies. 
Policy Regions provide a way to model the management and organization model of the distributed 
computing environment. For more information on Policy Regions, see Chapter 5: Policy and 
Policy Regions of the Tivoli Management Platform User’s Guide. 

4.2.2.2.6.1 Tivoli Profile Manager 

For a description of the Tivoli Profile Manager, see section 4.2.2.2.5.1. The GSFC Policy Region 
Profiles are Indicator Collection, Fault Profile Manager, Performance Profile Manager, Security 
Profile Manager. These Profile Managers are Sentry Profile Managers. For more information on 
Sentry, please see the Tivoli/Sentry User’s Guide and the Tivoli/Sentry Monitoring Collection 
Reference Manuals. For more information on Profile Managers, please see Chapter 6: 
Configuration Management of the Tivoli Management Platform User’s Guide. 

4.2.2.2.6.2 Tivoli Profiles 

Beneath the Profile Managers are Profiles. Profiles are collections of application-specific 
information. Each Profile is specific to a particular profile type and each profile contains 
configuration information. For more information on Profiles please see Chapter 6: Configuration 
Management of the Tivoli Management Platform User’s Guide. 

4.2.2.2.7 Tivoli Root-Region 

This Policy Region is created during initial installation and contains each of the Managed Nodes (a 
Tivoli client or any resource that is being managed by Tivoli). For more information on Policy 
Regions, see Chapter 5: Policy and Policy Regions of the Tivoli Management Platform User’s 
Guide. 

4.2.2.2.8 Scheduler 

The Tivoli Management Environment Scheduler allows the operator to schedule jobs to occur at 
specified times within a specified time frame. The operator can also schedule jobs to repeat a 
specified number of times during a specific time interval or schedule jobs to run indefinitely. For 
more information regarding the Scheduler, please see Chapter 9: TME Scheduler of the Tivoli 
Management Platform User’s Guide. 

4.2.2.3 Required Operating Environment 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product. To find the documentation for Tivoli, refer to the ECS Baseline 
Information System web page, URL http://cmdm.east.hitc.com/. 
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4.2.2.3.1 Interfaces and Data Types 

Tivoli exchanges data of various types through interfaces within and external to ECS. 
Table 4.2.2-2 lists Tivoli system interfaces for Version 2.0. 

Table 4.2.2-2. Interface Protocols 
Interface Type of Primary 

Interface 
Protocols 

Comments 

Object Request 
Broker 

Oserv Tivoli uses its Oserv to interface with other Tivoli 
oserv(s) 

Syslog Log File Adapter • Tivoli uses the Log File Adapter to read any ASCII 
log 

• The adapter has been customized in ECS Version 
2.0 to monitor some of the COTS logs 

Syslog HP OpenView 
Adapter 

Tivoli uses the HP OpenView Adapter to read the HP 
OpenView Trapd log 

Sentry Sentry Engine • Sentry Engine is used to intermediate the 
communications between the Monitors and the 
Oserv 

4.2.2.4 Databases 

Tivoli uses two databases, one is a Sybase database and one is a Tivoli proprietary database. 
Operators are unable to access any of the information that either of them contain. 

4.2.2.5 Special Constraints 

Anyone who has access to Tivoli has different roles and privileges as set by DAAC policy. 

4.2.2.6 Outputs 

The only output from Tivoli is information that is presented on the console. 

4.2.2.7 Event and Error Messages 

Tivoli issues status messages that are output to the Operation Status panel at the bottom of the 
Tivoli TME Desktop (For a brief description of Status Messages, see Status Messages on pages 1
16 of the Tivoli Management Platform User’s Guide (Release 2.5). Tivoli also posts messages to 
the Notifications Facility (for more information on the Notification Facility, see Chapter 7: 
Notification of the Tivoli Management Platform User’s Guide. Based on configuration, events and 
error messages are also posted to the appropriate Event Source of the Enterprise Console (for more 
information on the Enterprise Console, see the Tivoli Enterprise Console User’s Guide). 

Both event and error messages unique to ECS are listed in Appendix D. 
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4.2.2.8 Reports 

None. 
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4.2.3 Remedy’s Action Request System 

The Remedy Action Request System provides a distributed Trouble Ticketing Service that 
furnishes DAACs a common environment and the means of classifying, tracking, and reporting 
problem occurrences and resolutions to both ECS users and operations personnel. The Trouble 
Ticketing Service: 

• provides a GUI for operations personnel to access all Trouble Ticket services 

• provide a common Trouble Ticket entry format 

• stores Trouble Tickets 

• retrieves Trouble Tickets via ad-hoc queries 

• allows operations personnel to forward problems from one DAAC to another 

• generates reports and statistics 

• interfaces with user’s and operator’s e-mail to provide automatic notification 

•	 offers an application programming interface through which applications can submit Trouble 
Tickets 

•	 provides summary information to the SMC from each DAAC to allow trend reports 
regarding Trouble Tickets 

• defines a consistent “life-cycle” for Trouble Tickets 

•	 allows each DAAC a degree of customization through definition of further escalation and 
action rules 

Escalation rules are time activated events which execute on Trouble Tickets which meet a set of 
specified criteria. Actions which can be taken include notification (either a user or support staff 
member), writing to a log file, setting a field value on the Trouble Ticket, or even running a custom 
written process. Qualifications can be expressed on any Trouble Ticket data tracks. Active links are 
similar to escalation rules with the exception that they are defined to take place on a specified action 
rather than at a given time. 

In addition to the functionality provided by Remedy’s Action Request System, the Trouble 
Ticketing Service utilizes a set of custom HTML documents to provide registered users with the 
ability to submit new Trouble Tickets and query the current status of any of their previous entries. 
Access to the Trouble Ticketing system through this technique provides users an easy method for 
reporting problems in an environment already familiar to them. Additionally, as another means of 
Trouble Ticket entry, the Trouble Ticket services provide a text e-mail template through which 
automated entry of Trouble Tickets is possible. Support staff members enter Trouble Tickets 
through the Remedy’s Action Request System provided interface for problems received via other 
methods (e.g., phone calls). 
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In addition to tracking Trouble Tickets, the Remedy Action Request System also functions as the 
User Contact Log. Remedy’s Action Request System is configured to have a separate schema that 
contains the entries User Services personnel enter for each contact they have with a user. The User 
Contact Log allows a Trouble Ticket to be initiated from a log entry with the push of a button – the 
Trouble Ticket is populated with information from the contact log. 

Remedy’s Action Request System is used by User Services personnel to perform the functions 
listed in Table 4.2.3-1. 

Table 4.2.3-1. Common ECS Operating Functions Performed with 
Remedy’s Action Request System (1 of 4) 

Operating 
Function 

GUI (Section) Description When and Why to 
Use  

access Trouble 
Ticket services 

User Tool 
(4.2.3.2) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-Trouble Tickets 
schema 

• Main Remedy Trouble Ticket 
screen used to select the 
appropriate schema for 
submitting, modifying, or 
displaying a Trouble Ticket 

To submit, query, or 
work a Trouble Ticket 

submit a Trouble 
Ticket 

User Tool (RelB-
Trouble Tickets 
schema) 
(4.2.3.2) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-Trouble Tickets 
schema 

• Schema used to enter 
information about the 
problem 

When a problem is 
either found by or 
reported to User 
Services 

retrieve a Trouble 
Ticket 

User Tool (RelB-
Trouble Tickets 
schema) 
(4.2.3.2) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-Trouble Tickets 
schema 

• Trouble Ticket screen that 
contains information already 
filled out for a Trouble Ticket 

• Allows entry of new 
information about the 
problem 

When information is 
either added to or 
received from a 
Trouble Ticket 
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Table 4.2.3-1. Common ECS Operating Functions Performed with 
Remedy’s Action Request System (2 of 4) 

Operating 
Function 

GUI (Section) Description When and Why to 
Use  

forward a Trouble 
Ticket to another 
DAAC 

User Tool (RelB-
Trouble Ticket, 
RelB-TT-
ForwardToSite 
and RelB-TT-
Sites schemas) 
(4.2.3.2) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-Trouble Ticket, RelB-
TT-ForwardToSite and RelB-
TT-Sites schemas 

• Trouble Ticket contains all 
forwarding information; once 
forwarded, it goes to the 
RelB-TT-ForwardToSite 
holding area (transparent to 
the user) 

• The RelB-TT-Sites schema 
is used to indicate the site 
name and email address to 
be used in forwarding 

When a Trouble Ticket 
is deemed relevant to 
another site 

generate reports User Tool (RelB-
Trouble Tickets 
schema) 
(4.2.3.2) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-Trouble Tickets 
schema 

• reports to be created can be 
specified via the 
Query/Report pull-down 
menu 

When information is 
needed about one or 
more Trouble Tickets 

add, delete, or 
update user 
accounts 

User Tool (RelB-
User schema) 
(4.2.3.2.1) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-User schema 

• Screen that contains key 
information about a user 
account 

To add new Remedy 
users, delete old users 
or when users change 
jobs and need new 
access privileges 

Create/Update 
User Contact Log 
entry and submit a 
Trouble Ticket 
from a log entry 

User Tool 
(Contact Log 
schema) 
(4.2.3.2.2) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-Contact Log schema 

• Used to classify, track, and 
report contacts of ECS users 
and operators 

Record user contacts 
and generate Trouble 
Tickets if log entry is 
determined to be a 
Trouble Ticket 

4.2.3-3 609-CD-003-004




Table 4.2.3-1. Common ECS Operating Functions Performed with 
Remedy’s Action Request System (3 of 4) 

Operating 
Function 

GUI (Section) Description When and Why to 
Use  

provide a 
description of a 
hardware problem 
that corresponds 
to a Trouble Ticket 

User Tool 
(Hardware 
Information 
schema) 
(4.2.3.2.3) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-Hardware Information 
schema, or via Hardware 
Information link from Trouble 
Tickets schema 

• screen used to enter 
detailed information about 
failed hardware components 
(e.g., part and serial 
numbers) and the actions 
taken to correct the problem 

If detailed hardware 
information needs to 
be provided beyond 
what can be entered 
on the Trouble Tickets 
schema 

customize 
pulldown menus 
on RelB-Trouble 
Tickets schema 

User Tool (RelB-
Menu-Closing 
Codes, RelB-
Menu-Hardware 
Resources, 
RelB-Menu-
Software 
Resources, 
RelB-Menu-Key 
Words, RelB-
Menu-Problem 
Type, Sites 
schema) 
(4.2.3.2.4
4.2.3.2.8) 

• Accessed by clicking on 
User Tool icon and opening: 
RelB-Menu-Closing Codes, 
RelB-Menu-Hardware 
Resources, 
RelB-Menu-Software 
Resources, RelB-Menu-Key 
Words, 
RelB-Menu-Problem Type, 
Sites schema 

• picklist items can be added, 
deleted, or modified from 
these schemata 

If current menu is 
inadequate 

add, delete, 
modify a site name 
and email address 

User Tool (RelB-
TT-Sites 
schema) 
(4.2.3.2.9) 

• Accessed by clicking on 
User Tool icon and opening 
RelB-TT-Sites schema 

• Provides a picklist of Version 
2.0 sites (DAACs), SMC, 
NSI, and EBNet 

To indicate the site 
name and email 
address used in 
forwarding 

notification and/or 
customization at 
different states of 
a Trouble Ticket 

Admin Tool and 
User Tool (RelB-
TT-Times 
schema) 
(4.2.3.2.10) 

• Accessed by clicking on 
AdminTool to open correct 
filter, escalation, or active link 

• Accessed by clicking on 
User Tool icon and opening 
RelB-TT-Times schema to 
review/modify a Trouble 
Ticket 

To notify or set fields 
as soon as a Trouble 
Ticket reaches a 
particular state or 
escalate once a 
Trouble Ticket is in a 
particular state too long 
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Table 4.2.3-1. Common ECS Operating Functions Performed with 
Remedy’s Action Request System (4 of 4) 

Operating 
Function 

GUI (Section) Description When and Why to 
Use  

notify the user of a 
Remedy event 

Notification Tool 
(4.2.3.2.12) 

• Accessed by clicking on 
Remedy Notification Tool 
icon 

• Allows properties and 
options to be modified via 
pull-down menus 

Used as an alternative 
to email notification 

import entries into 
a particular 
schema 

Import Tool 
(4.2.3.2.13) 

• Accessed by clicking on 
Remedy Import Tool icon 

• Enables the user to import 
entries into a schema from a 
file generated by the Admin 
tool 

Used to import existing 
entries rather than 
retyping information 
manually 

submit a Trouble 
Ticket via HTML 

Trouble Ticket 
HTML 
(4.2.3.2.14) 

• Accessed by clicking on the 
Trouble Ticket icon 

• submit, obtain a list and view 
details of Trouble Tickets 

Used by both User 
Services and the end 
user to submit Trouble 
Tickets without going 
through Remedy 

4.2.3.1 Quick Start Using Remedy’s Action Request System 

This section describes how to invoke Remedy and provides a description of customized Remedy 
GUIs. Standard Remedy features (e.g., pull-down menus) are not discussed in this document. For 
more information on Remedy’s Action Request System, refer to the following: 

•	 See Remedy’s Action Request System User’s Guide, Chapter 1 “Overview of the Action 
Request System,” page 1-1 

•	 See Remedy’s Action Request System User’s Guide, Chapter 2 “Getting Started with the 
User Tool,” page 2-1 

•	 See Remedy’s Action Request System User’s Guide, Chapter 3 “Submitting an Action 
Request,” page 3-1 

•	 See Remedy’s Action Request System User’s Guide, Chapter 4 “Reviewing and 
Modifying Action Requests,” page 4-1 

•	 See Remedy’s Action Request System User’s Guide, Chapter 8 “Using the Notification 
Tool,” page 8-1 

•	 For information on the fields of the GUIs shown in this section, please use the Context 
Sensitive Help that is available for that GUI. 

The documentation of AR System used as a basis and referenced in this section is for 
version/release 2.1.3, contained in ECS Release 4. 
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4.2.3.1.1 Invoking Remedy’s Action Request System 
Line Interface 

To execute AR User tool from the command line prompt use: 

$AR_INSTALL_DIR/bin/aruser & 

To execute AR Admin tool from the command line prompt use: 

$AR_INSTALL_DIR/bin/aradmin & 

To execute AR Notification tool from the command line prompt use: 

$AR_INSTALL_DIR/bin/notifier & 

To execute AR Import tool from the command line prompt use: 

$AR_INSTALL_DIR/bin/arimport & 

From the Command 

4.2.3.1.2 Invoking Remedy’s Action Request System From the ECS Desk 
top 

To invoke the HTML interface to Remedy’s Action Request System (see Section 4.2.3.2.14), click 
on the Trouble Ticketing icon from the ECS Desktop. 

Trouble Ticketing 

Figure 4.2.3-1. Trouble Ticket Icon (on ECS Desktop) 

The other Remedy tools referenced are invoked with the commands described above. 

4.2.3.2 Remedy’s User Tool Main Screen (RelB-Trouble Tickets Schema) 

Remedy’s Action Request System User Tool Main screen is the RelB-Trouble Tickets Schema 
GUI shown in Figure 4.2.3-2 below. From here Trouble Tickets can be submitted, queried or 
modified. 
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Figure 4.2.3-2. RelB-Trouble Tickets Schema GUI 

Table 4.2.3-2 below provides a description of the RelB-Trouble Tickets Schema fields. 
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Table 4.2.3-2. RelB-Trouble Tickets Field Descriptions (1 of 2) 
Field Name Data Type S ize  Entry Description 

Ticket-Id Character 15 System 
generated 

Ticket number which is set and 
maintained by the system 

Ticket Status Selection 4 Required Status of the Trouble Ticket 

Assigned-Priority Selection 4 Required Priority of Trouble Ticket assigned at 
the site 

Short Description Character 128 Required Short Description of the problem 

Submitter Impact Selection 4 Optional Impact of the problem to the 
submitter 

Long-Description Character 255 Optional Long Description of the problem 

Resolution Log (End 
User Sees) 

Diary Unlim Optional General steps in the resolution of the 
problem 

Detailed Resolution Log Diary Unlim Optional Detailed steps in problem resolution 

Submitter ID Character 30 Required User Id of the Submitter 

Submitter Name Character 30 Optional Full Name of the Submitter 

Submitter Phone Character 30 Optional Phone number of the Submitter 

Submitter eMail Character 64 Optional E-mail address of the Submitter 

Submitter Home DAAC Character 60 Optional Home DAAC of the Submitter 

History Diary Unlim Optional • Upon submission or modification, 
the person assigned to the ticket 
and the ticket status are indicated 
in the History field 

• Due to a limitation in Remedy, this 
information is only written when the 
Assigned-to and Status fields are 
modified 

Assigned-To Character 30 Optional Person who Trouble Ticket has been 
assigned to 

Last-modified-by Character 30 System 
generated 

Person who last modified the 
Trouble Ticket 

Create-date Date/Time 4 System 
generated 

Date Trouble Ticket was created at 
the present site (mm/dd/yy and 
hh:mm:ss) 

Last-Modified-date Date/Time 4 System 
generated 

Date the Trouble Ticket was last 
modified (mm/dd/yy and hh:mm:ss) 

Related CCR Character 60 Optional ID of a related CCR 

Key Words Character 255 Optional Key words to help identify this 
Trouble Ticket (e.g., Hardware, 
Software, Configuration) 
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Table 4.2.3-2. RelB-Trouble Tickets Field Descriptions (2 of 2) 
Field Name Data Type S ize  Entry Description 

Problem Type Character 30 Optional Type of problem addressed by this 
Trouble Ticket (e.g., Configuration 
Error, Hardware Problem, Software 
Problem) 

Closing Code Character 60 Optional Origin of the problem that this 
Trouble Ticket resulted from 

Closed-by Character 60 Optional Person that closed this Trouble 
Ticket 

Close-date Date/Time 4 Optional Date this Trouble Ticket was closed 

Software Resource Character 60 Optional Software Resource that the problem 
came from 

Hardware Resource Character 60 Optional Hardware Resource that this problem 
came from 

Duplicate Master Id Character 25 Optional The Master Ticket-ID of this Trouble 
Ticket 

Forward-to Character 60 Optional Site that this Trouble Ticket was last 
forwarded to 

Forwarded-from Character 60 Optional Site that forwarded this Trouble 
Ticket 

Forwarded-by Character 60 Optional Contact person at the forwarding site 

Forward-date Date/Time 4 Optional Date Trouble Ticket was forwarded 

Unique-Identifier Character 20 Optional • Unique identifier which is 
established at the origination site 

• This identifier should NEVER be 
changed once set 

Forwarded-to-1 Character 60 Optional First site to have been forwarded this 
Trouble Ticket 

Forwarded-to-2 Character 60 Optional Second site to have been forwarded 
this Trouble Ticket 

Forwarded-to-3 Character 60 Optional Third site to have been forwarded 
this Trouble Ticket 

Forwarded-to-4 Character 60 Optional Fourth site to have been forwarded 
this Trouble Ticket 

Associated Contact Log 
Id 

Character 30 Optional ID number of the Associated Contact 
Log 

In addition to the fields described in the above table, the RelB-Trouble Tickets Schema provides 
the following active links: 

• Forward -- Forwards this Trouble Ticket to the site specified in the "Forward-to" field. 

•	 Hardware Information -- Opens a window that is associated with this Trouble Ticket to 
hold hardware information. 

•	 List All Masters -- All Trouble Tickets that are duplicates of each other have one master. 
This button lists all master Trouble Tickets. 
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--

•	 List This TT’s Duplicate(s) -- List all Trouble Tickets that have duplicates associated 
with this Trouble Ticket. 

•	 Go to Contact Log If this Trouble Ticket was created from a Contact Log then this 
button opens a window to that Contact Log 

4.2.3.2.1 Remedy’s User Tool Screen (User Schema) 

The "User" schema, shown in Figure 4.2.3-3 below, is used by the administrator to add, modify 
or remove users of the Action Request (AR) System. The "User" schema is used in conjunction 
with the "Group" schema to provide users with permissions that ultimately determine which 
operations individual users can perform and which schemas and fields they can access. For more 
information on the "User" schema and the AR System access control, please refer to the Action 
Request System Administrator's Guide. 
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Figure 4.2.3-3. User Schema GUI 

Table 4.2.3-3 below provides a description of the User Schema fields. 
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Table 4.2.3-3. User Schema Field Descriptions 
Field Name Data Type S ize  Entry Description 

Entry-Id Character 15 System 
generated 

Entry ID of user 

Status Selection 4 Required Is user current or not? 

License Type Selection 4 Required What type of license does this user 
have? (e.g., read, fixed, floating) 

Login name Character 30 Required Login name of user 

Password Character 30 Optional Password of User 

Email Address Character 255 Required E-mail address of User 

Group list Character 255 Optional Groups to which the user belongs 

Full Name Character 128 Required Full Name of User 

Phone Number Character 55 Required Phone Number of User 

Home DAAC Character 55 Required Home DAAC of User 

Default Notify 
Mechanism 

Selection 4 Optional Notification method 

Full Text License Type Selection 4 Required Not applicable 

Creator Character 30 Required Person who created the user account 

Create-date Date/Time 4 System 
generated 

Date that the entry was created at the 
present site (mm/dd/yy and hh:mm:ss) 

Last-modified-by Character 30 System 
generated 

User ID of person that last modified 
the user entry 

Modified-date Date/Time 4 System 
generated 

Date of last modification to user entry 
(mm/dd/yy and hh:mm:ss) 

4.2.3.2.2 Remedy’s User Tool Screen (Contact Log Schema) 

The Contact Log Schema GUI, shown in Figure 4.2.3-4 below, is used to enter information about 
a contact to User Services. 
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Figure 4.2.3-4. Contact Log Schema GUI 

Table 4.2.3-4 below provides a description of the Contact Log Schema fields. 
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Table 4.2.3-4. Contact Log Schema Field Descriptions 
Field Name Data Type S ize  Entry Description 

Log-Id Character 15 System 
generated 

ID of Contact Log 

Log Status Selection 4 Required Status of Contact Log 

Contact Method Character 50 Optional Method that was used to contact the 
person entering the Contact 
Information 

Short Description Character 128 Required Short Description of the contact 

Associated TT Id Character 60 Optional If a Trouble Ticket is created from this 
Contact Log then this is the related 
Trouble Ticket ID 

Long Description Character 255 Optional Long Description of the contact 

Comment Log Diary Unlim Optional Any comments that may pertain to the 
contact 

Contact Id (Required for 
TT) 

Character 30 Optional User ID of person calling in 
Required to create a Trouble Ticket 

Receiving Operator Character 30 Required Person that receives and enters call 

Category Character 60 Optional Category of the contact 

Contact Name Character 30 Optional Name of person calling in 

Contact Phone Character 20 Optional Phone number of person calling in 

Contact E-mail Character 64 Optional E-mail of person calling in 

Contact Home DAAC Character 60 Optional Home DAAC of person calling in 

Contact Organization Character 60 Optional Organization of person calling in 

Received Time Date/Time 4 Optional Time the contact was first made 

Entered Time Date/Time 4 System 
generated 

Time initial information is entered. 

Modified-date Date/Time 4 System 
generated 

Date of last modification to this 
Contact Log 
(mm/dd/yy and hh:mm:ss) 

Last-modified-by Character 30 System 
generated 

User ID of person that last modified 
this Contact Log (mm/dd/yy and 
hh:mm:ss) 

4.2.3.2.3 Remedy’s User Tool (Hardware Information Schema) 

The Hardware Information Schema GUI shown in Figure 4.2.3-5 below is used to enter 
information about a particular piece of hardware that corresponds to a Trouble Ticket. 
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Figure 4.2.3-5. Hardware Information Schema GUI 

Table 4.2.3-5 below provides a description of the Hardware Information Schema fields. 
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Table 4.2.3-5. Hardware Information Schema Field Descriptions (1 of 3) 
Field Name Data Type S ize  Entry Description 

Entry-Id Character 15 System 
generated 

Entry ID of user 

Create-date Date/Time 4 System 
generated 

Date that the entry was created at the 
present site (mm/dd/yy and hh:mm:ss) 

Last-modified-by Character 30 System 
generated 

User ID of person that last modified the 
Hardware Information screen 

Related Trouble Ticket 
Number 

Character 30 Required ID of a related Trouble Ticket 

Modified-date Date/Time 4 System 
generated 

Date of last modification to Hardware 
Information screen (mm/dd/yy and 
hh:mm:ss) 

Date of Report Character 255 Optional Date that the problem was reported 
(mm/dd/yy and hh:mm:ss) 

Date and Time of 
Malfunction 

Character 255 Optional Date and time that the problem was 
noticed or approximate time of failure 

Site Location of 
Malfunction 

Character 255 Optional DAAC site where the problem occurred 

Room number of 
Malfunction 

Character 255 Optional DAAC room number where the problem 
occurred 

Parent System ECS 
name 

Character 255 Optional Site-specific ECS name of the parent 
system 

Parent System CI Character 255 Optional Associated Baseline control item ID of 
parent system 

Parent System OS 
version 

Character 255 Optional Operating system version of the parent 
system 

Parent System 
Manufacturer 

Character 255 Optional Name of parent system vendor 

Parent System 
Model/Version 

Character 255 Optional Model name and version numbers of the 
parent system 

Parent System ECN 
number 

Character 255 Optional Equipment control number of parent 
system 

Parent System Serial 
Number 

Character 255 Optional Serial number of parent system 

Parent System total 
oper. hrs. 

Character 255 Optional Number of cumulative hours the parent 
system has been in operation (since the 
last failure) 

Maint Vendor 
assigned to 

Character 255 Optional Name of the vendor contracted to 
maintain the hardware 

Maint Vendor phone 
number 

Character 255 Optional Maintenance vendor point of contact 
phone number 

Maint PO/Contract 
number 

Character 255 Optional Purchase order and contract number for 
maintenance vendor 
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Table 4.2.3-5. Hardware Information Schema Field Descriptions (2 of 3) 
Field Name Data Type S ize  Entry Description 

Maint Reference/Case 
number 

Character 255 Optional Reference/case number assigned by the 
vendor for the hardware problem 

Date and Time 
assigned/called 

Character 255 Optional Date and time that the maintenance 
vendor was called and notified of the 
problem 

Technician assigned 
to 

Character 255 Optional Name of vendor maintenance technician 

System malf. error 
messages 

Character 255 Optional Error messages provided by the system 

Failure Impact Rating Character 255 Optional Failure criticality or severity rating 

Comments Character 255 Optional Field to provide any additional comments 

Corrective actions 
taken 

Character 255 Optional Actions taken to resolve the problem 

Failed/replacement 
item desc. 

Character 255 Optional Description of the failed component and 
its replacement 

Failed item total 
operating hr 

Character 255 Optional Number of hours the failed component 
was used in operation 

Failed item 
Manufacturer/model 

Character 255 Optional Manufacturer name and model number of 
failed component 

Replacement item 
Manufat/model 

Character 255 Optional Manufacturer name and model of 
replacement component 

Failed item part 
number 

Character 255 Optional Vendor part number of failed component 

Replacement item part 
number 

Character 255 Optional Vendor part number of replacement 
component 

Failed item serial 
number 

Character 255 Optional Serial number of failed component 

Replacement item 
serial number 

Character 255 Optional Serial number of replacement component 

Failed item ECN Character 255 Optional Equipment control number of failed 
component 

Replacement item 
ECN 

Character 255 Optional Equipment control number of 
replacement component 

Time to repair in clock 
hours 

Character 255 Optional Elapsed time (not including delays) in 
clock hours taken to troubleshoot and 
isolate the problem, replace the 
component, and test and verify the fix 

Total sys. down time 
clock hrs 

Character 255 Optional Elapsed time in clock hours that the 
system was down for repair (includes 
administrative and logistical delays) 

Malfunction resolved 
by 

Character 255 Optional Name of person who resolved the 
problem 
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Table 4.2.3-5. Hardware Information Schema Field Descriptions (3 of 3) 
Field Name Data Type S ize  Entry Description 

Resolve date and time Character 255 Optional Date and time the problem was resolved 
(see Remedy documentation for the most 
efficient format) 

Corrective action 
verified by 

Character 255 Optional Person who verified that the problem has 
been resolved 

Verification date and 
time 

Character 255 Optional Date and time that problem resolution was 
verified 

FRB date reviewed Character 255 Optional Date the Failure Review Board reviewed 
the problem and corrective action 

Corr. action effective. 
rating 

Character 255 Optional Effectiveness rating assigned by Failure 
Review Board (FRB) 

Red Flag reportable 
(y/n) 

Character 255 Optional Record of FRB determining if the 
problem meets Red Flag reporting criteria 

Date Red Flag report 
submitted 

Character 255 Optional If the problem meets Red Flag criteria, the 
date it was reported 

Quality assurance 
name 

Character 255 Optional Name of quality assurance person 
reviewing the problem and its resolution 

Quality assurance date Character 255 Optional Date the quality assurance person 
reviewed the problem and its resolution 

ECS closure authority 
name 

Character 255 Optional Name of person from the ECS review 
board who can close the Trouble Ticket 

ECS closure authority 
date 

Character 255 Optional Date the ECS review board closed the 
Trouble Ticket 

GSFC malfunction 
report date 

Character 255 Optional Date the malfunction was reported to the 
GSFC review board 

GSFC final approval 
name 

Character 255 Optional Name of person from GSFC review board 
who can approve problem and its 
resolution 

GSFC final approval 
date 

Character 255 Optional Date approved by GSFC review board 

4.2.3.2.4 Remedy’s User Tool (RelB-Menu-Closing Codes Schema) 

The RelB-Menu-Closing Codes schema GUI, shown in Figure 4.2.3-6 below, is used to add, 
delete, or modify the picklist of the field Closing Code. 
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Figure 4.2.3-6. RelB-Menu-Closing Codes Schema GUI 

Table 4.2.3-6 below provides a description of the RelB-Menu-Closing Code schema fields. 
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Table 4.2.3-6. RelB-Menu-Closing Codes Field Descriptions 
Field Name Data Type S ize  Entry Description 

Closing Code Character 2 Required Two letter code that corresponds with 
the Closing Description; this is where 
codes can be added, deleted or 
changed 

Closing Description Character 128 Required Problem summary 

Last-modified-by Character 30 System 
generated 

User ID of person that last modified 
the closing codes 

Modified-date Date/Time 4 System 
generated 

Date of last modification to closing 
codes (mm/dd/yy and hh:mm:ss) 

Create-date Date/Time 4 System 
generated 

Date the closing codes were created 
at the present site (mm/dd/yy and 
hh:mm:ss) 

4.2.3.2.5 Remedy’s User Tool (RelB-Menu-Hardware Resources Schema) 

The RelB-Menu Hardware Resources Schema GUI, shown in Figure 4.2.3-7 below, is where one 
adds, deletes, or modifies the picklist of the field Hardware Resource. 
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Figure 4.2.3-7. Tool RelB-Menu-Hardware Resources Schema GUI 

Table 4.2.3-7 below provides a description of the RelB-Menu-Hardware Resources Schema fields. 
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Table 4.2.3-7. RelB-Menu-Hardware Resources Schema 
Field Descriptions 

Field Name Data Type S ize  Entry Description 

Hardware Resource Character 3 0 Required Hardware resource to be added, 
deleted or modified 

Status Selection 4 Required Status for this hardware resource 

Last-modified-by Character 3 0 System 
generated 

User ID of person that last modified 
the hardware resources 

Modified-date Date/Time 4 System 
generated 

Date of last modification to hardware 
resources (mm/dd/yy and hh:mm:ss) 

Create-date Date/Time 4 System 
generated 

Date the hardware resource was 
created at the present site (mm/dd/yy 
and hh:mm:ss) 

4.2.3.2.6 Remedy’s User Tool (RelB-Menu-Key Words Schema) 

The RelB-Menu-Key Words Schema GUI, shown in Figure 4.2.3-8 below, is used to add, delete, 
or modify the picklist of the field Key Word. 

Figure 4.2.3-8. RelB-Menu-Key Words Schema GUI 
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Table 4.2.3-8 below provides a description of the RelB-Menu-Key Words Schema fields. 

Table 4.2.3-8. RelB-Menu-Key Words Schema Field Descriptions 
Field Name Data Type S ize  Entry Description 

Key Word Character 30 Required Key word for the Trouble Ticket; this 
is where key words can be added, 
deleted or modified 

Last-modified-by Character 30 System 
generated 

User ID of person that last modified 
the Key Words 

Modified-date Date/time 4 system 
generated 

Date of last modification to Key 
Words (mm/dd/yy and hh:mm:ss) 

Create-date Date/time 4 system 
generated 

Date that the Key Words were 
created at the present site 
(mm/dd/yy and hh:mm:ss) 

4.2.3.2.7 Remedy’s User Tool (RelB-Menu-Problem Type Schema) 

The RelB-Menu-Problem Type Schema GUI, shown in Figure 4.2.3-9 below, is used to add, 
delete, or modify the picklist of the field Problem Type. 
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Figure 4.2.3-9. RelB-Menu-Problem Type Schema GUI 

Table 4.2.3-9 below provides a description of the RelB-Menu-Problem Type Schema fields. 
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Table 4.2.3-9. RelB-Menu-Problem Type Schema Field Descriptions 
Field Name Data Type S ize  Entry Description 

Problem Type Character 30 Required Problem type of the Trouble Ticket; 
this is where problem types can be 
added, deleted or modified 

Last-modified-by Character 30 System 
generated 

User ID of person that last modified 
the Problem Type 

Modified-date Date/Time 4 System 
generated 

Date of last modification to Problem 
Type (mm/dd/yy and hh:mm:ss) 

Create-date Date/Time 4 System 
generated 

Date the Problem Type was created at 
the present site (mm/dd/yy and 
hh:mm:ss) 

4.2.3.2.8 Remedy’s User Tool (RelB-Menu-Software Resources Schema) 

The RelB-Menu-Software Resources Schema GUI, shown in Figure 4.2.3-10 below, is used to 
add, delete, or modify the picklist of the field Software Resource. 

Figure 4.2.3-10. RelB-Menu-Software Resources Schema GUI 
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Table 4.2.3-10 provides a description of the RelB-Menu-Software Resource Schema fields. 

Table 4.2.3-10. RelB-Menu-Software Resources Schema 
Field Descriptions 

Field Name Data Type S ize  Entry Description 

Software Resource Character 3 0 Required Software resource to be added, 
deleted or modified 

Status Selection 4 Required Current or historical status of this 
software resource 

Last-modified-by Character 3 0 System 
generated 

User ID of person that last modified 
the software resources 

Modified-date Date/Time 4 System 
generated 

Date of last modification to software 
resources (mm/dd/yy and hh:mm:ss) 

Create-date Date/Time 4 System 
generated 

Date the software resources were 
created at the present site (mm/dd/yy 
and hh:mm:ss) 

4.2.3.2.9 Remedy’s User Tool (RelB-TT-Sites Schema) 

The RelB-TT-Sites Schema GUI, shown in Figure 4.2.3-11 below, indicates the site name and 
email address to be used in forwarding. 
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Figure 4.2.3-11. RelB-TT-Sites Schema GUI 

Table 4.2.3-11 below provides a description of the RelB-TT-Sites schema fields. 
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Table 4.2.3-11. RelB-TT-Sites Schema Field Descriptions 
Field Name Data Type S ize  Entry Description 

Site Name Character 128 Required Name of EOS Site 

Email Address Character 255 Optional E-mail address of EOS Site 

Remedy Server Character 55 Optional Name of server at site that Remedy is installed 

Site 
Abbreviation 

Character 255 Optional Abbreviation of site name 

Create-date Date/Time 4 System 
generated 

Date the RelB-TT-Sites were created at the 
present site (mm/dd/yy and hh:mm:ss) 

Modified-date Date/Time 4 System 
generated 

Date of last modification to RelB-TT-Sites 
(mm/dd/yy and hh:mm:ss) 

Last-modified-by Character 30 System 
generated 

User ID of person that last modified the RelB-
TT-Sites 

Submitter Character 30 Required User ID 

4.2.3.2.10 Remedy’s User Tool (RelB-TT-Times Schema) 

The RelB-TT-Times Schema GUI (Figure 4.2.3-12) is used to indicate escalation times. 
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Figure 4.2.3-12. RelB-TT-Times Schema GUI 

Table 4.2.3-12 below provides a description of the RelB-TT-Times Schema fields. 
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Table 4.2.3-12. RelB-TT-Times Schema Field Descriptions 
Field Name Data Type S ize  Entry Description 

Entry-Id Character 15 System 
generated 

Entry ID of Time entry 

Time-Id Character 30 Required Escalation ID of Time entry 

Time Interval (in 
seconds) 

Integer 4 Optional Time interval (in seconds) for escalation to 
take place 

Description Character 128 Required What escalation that this time corresponds 

Modified-date Date/Time 4 System 
generated 

Date of last modification to RelB-TT-Sites 
(mm/dd/yy and hh:mm:ss) 

Last-modified-by Character 30 System 
generated 

User ID of person that last modified the RelB-
TT-Sites 

Create-date Date/Time 4 System 
generated 

Date the RelB-TT-Sites were created at the 
present site (mm/dd/yy and hh:mm:ss) 

4.2.3.2.11 Remedy’s Admin Tool (Schema List Schema) 

For more information on the Schema List schema, see Remedy’s Action Request System User’s 
Guide, Chapter 1, “Administrator Tool,” pages 1-4. 
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Figure 4.2.3-13. Schema List Schema GUI 

Table 4.2.3-13 below provides a description of the Schema List Schema fields. 
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Table 4.2.3-13. Schema List Schema Field Descriptions 
Field Name Data Type S ize  Entry Description 

Category-> 
Schema (List) 

Character Variable System 
Generated 

List of available 
schemas. 

Category-> 
Menus (List) 

Character Variable System 
Generated 

List of available 
menus. 

Category-> 
Filters (List) 

Character Variable System 
Generated 

List of available 
filters. 

Category-> 
Escalations (List) 

Character Variable System 
Generated 

List of available 
escalations 

Category-> 
Active Links 
(List) 

Character Variable System 
Generated 

List of available 
active links. 

4.2.3.2.12 Remedy’s Notification Tool 

For more information on the Notification Tool, see Remedy’s Action Request System User’s 
Guide, Chapter 1, “Notification Tool,” pages 1-3. 

Figure 4.2.3-14. Notification Tool GUI 

Table 4.2.3-14 below provides a description of the Notification fields. 
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Table 4.2.3-14. Notification Field Descriptions 
Field Name Data Type S ize  Entry Description 

Date Character Variable System Generated Timestamp of the 
notification 

Source Character Variable System Generated Source of the trouble 
ticket 

Message Character Variable System Generated The short description 
from the trouble ticket 

Total number 
of notifications 

Integer Variable System Generated Current count of the total 
number of notifications 
assigned 

4.2.3.2.13 Remedy’s Import Tool 

For more information on the Import Tool, see Remedy’s Action Request System User’s Guide, 
Chapter 1, “Import Tool, ” pages 1-4 . 

Figure 4.2.3-15. Import Tool GUI 
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Table 4.2.3-15 below provides a description of the Import fields. 

Table 4.2.3-15. Import Field Descriptions 
Field Name Data Type S ize  Entry Description 

Schema Character Variable System 
Generated 

Selected in File-> Open Schema 

Import File Character Variable System 
Generated 

Selected in File-> Open Import 
File 

File Format Character Variable System 
Generated 

Selected in File-> Open Import 
File-> File Formats 

Schema Fields Character Variable System 
Generated 

Displays fields available in the 
selected schema 

Import Fields Character Variable System 
Generated 

Fields available in the selected 
import file 

Schema Field Character Variable User 
Selected 

Schema Field chosen to map to 
the import file field 

Mapping Character Variable User 
Selected 

import file field chosen to map to a 
schema field 

Field / Mapping Character Variable System 
Generated 

Displays the chosen import / 
schema mappings 

4.2.3.2.14 Remedy’s End-User Trouble Ticketing HTML Main Screen 

The HTML Trouble Ticket main screen (“ECS Trouble Ticketing: Menu”), shown in 
Figure 4.2.3-16 below, provides an introduction on how to use the Trouble Ticketing HTML, and 
is used by User Services personnel to go to either the Submit page or List page. 
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Figure 4.2.3-16. ECS Trouble Ticketing: (Netscape) Menu GUI 

Selecting Submit a Trouble Ticket brings up the Trouble Ticketing: Submit GUI described in 
Section 4.2.3.2.15. 

Selecting List [username] Trouble Tickets brings up the Trouble Ticketing: List GUI 
described in Section 4.2.3.2.17. 

Help on the Trouble Ticket HTML screens is available by clicking on the Trouble Ticket icon at the 
bottom of the screen (see Section 4.2.3.2.19). 
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4.2.3.2.15 Remedy’s End-User Trouble Ticketing HTML Submit GUI 

The HTML Trouble Ticket Submit GUI, shown in Figure 4.2.3-17 below, is used by User 
Services personnel to Submit a Trouble Ticket. 
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Figure 4.2.3-17. Trouble Ticket HTML Submit GUI 
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Table 4.2.3-16 below provides a description of the Trouble Ticket HTML Submit fields. 

Table 4.2.3-16. Trouble Ticket HTML Submit Screen Field Descriptions 
Field Name Data Type S ize  Entry Description 

ID character 30 System 
generated 

Submitter Id 

Name character 30 System 
generated 

Submitter Name 

E-mail address character 64 System 
generated 

Submitter E-mail Address 

Phone character 30 System 
generated 

Submitter Phone Number 

Home DAAC character 60 System 
generated 

Submitter Home DAAC 

Impact selection 4 Required Impact to Submitter 

Short description character 125 Required Short description of problem 

Detailed problem 
description 

character 245 Optional Long description of problem 

When the information is completed, the user can submit the Trouble Ticket by clicking on the 
Submit button on the lower half of the screen. The Problem Information Fields can be cleared by 
clicking on the Reset button. The user also has the choice of returning to the Trouble Ticketing 
Homepage or going to the Trouble Ticketing Help screen (Section 4.2.3.21) by clicking on the 
respective icons at the bottom of the page. 

4.2.3.2.16 Remedy’s End-User Trouble Ticketing HTML Success GUI 

The HTML Trouble Ticket Success screen, shown in Figure 4.2.3-18 below, is used by User 
Services personnel to insure successful submission and report Trouble Ticket Id. 
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Figure 4.2.3-18. Trouble Ticket HTML Success GUI 
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From this screen, the user is provided with the following information/options: 

•	 The Trouble Ticket was successfully submitted, Trouble Ticket identification number and 
who submitted it 

•	 Notification that an e-mail message has been sent to the user indicating that a Trouble Ticket 
has been submitted and when it was closed. Selecting this Trouble Ticket will open the 
Trouble Ticket Detailed Screen (see Section 4.2.3.2.18). 

• Instructions telling the user how to check the progress of Trouble Ticket resolution. 

The user also has the choice of returning to the Trouble Ticketing Homepage or going to the 
Trouble Ticketing Help screen (Section 4.2.3.2.19) by clicking on the respective icons at the 
bottom of the page. 

4.2.3.2.17 Remedy’s End-User Trouble Ticketing HTML List GUI 

The HTML Trouble Ticket List GUI, shown in Figure 4.2.3-19 below, is used by User Services 
personnel to List Trouble Tickets for a user and links the listed Trouble Ticket Number to the 
Trouble Ticket Detailed GUI (see Section 4.2.3.2.18). 
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Figure 4.2.3-19. Trouble Ticket HTML List GUI 
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Table 4.2.3-17 below provides a description of the Trouble Ticket HTML List fields. 

Table 4.2.3-17. Trouble Ticket HTML List Field Descriptions 
Field Name Data Type S ize  Entry Description 

Trouble Ticket Number character 15 System 
generated 

Trouble Ticket Id 

Problem Short 
Description 

character 125 System 
generated 

Short Description of Problem 

Status character 20 System 
generated 

Status of Trouble Ticket 

The user also has the choice of returning to the Trouble Ticketing Homepage or going to the 
Trouble Ticketing Help screen (Section 4.2.3.2.19) by clicking on the respective icons at the 
bottom of the page. 

4.2.3.2.18 Remedy’s End-User Trouble Ticketing HTML Detailed GUI 

The HTML Trouble Ticket Detailed GUI, shown in Figure 4.2.3-20 below, is used by User 
Services personnel to see a more detailed output of a Trouble Ticket. 
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Figure 4.2.3-20. Trouble Ticket HTML Detailed GUI 
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Table 4.2.3-18 below provides a description of the Trouble Ticket HTML Detailed fields. 

Table 4.2.3-18. Trouble Ticket HTML Detailed Field Descriptions 
Field Name Data Type S ize  Entry Description 

ID character 30 System 
generated 

Submitter Id 

Name character 30 System 
generated 

Submitter Name 

E-mail address character 64 System 
generated 

Submitter E-mail Address 

Phone character 30 System 
generated 

Submitter Phone Number 

Home DAAC character 60 System 
generated 

Submitter Home DAAC 

Status selection 4 System 
generated 

Status of Trouble Ticket 

Impact selection 4 System 
generated 

Impact to Submitter 

Short description character 125 System 
generated 

Short description of problem 

Detailed description character 245 System 
generated 

Long description of problem 

Log character unlim 
. 

System 
generated 

Diary of problem resolution 

The user also has the choice of returning to the Trouble Ticketing Homepage or going to the 
Trouble Ticketing Help screen (Section 4.2.3.2.19) by clicking on the respective icons at the 
bottom of the page. 

4.2.3.2.19 Remedy’s End-User HTML Trouble Ticketing Help GUI 

The HTML Trouble Ticket Help GUI, shown in Figure 4.2.3-21 below, is used by User Services 
personnel to get help with the HTML screens. 
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Figure 4.2.3-21. HTML Trouble Ticket Help GUI 
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This screen provides general information on the following: 

•	 Index -- links that scroll the screen to the Introduction, Submit Page, and List Page sections 
listed below. 

• Introduction – provides information about the Trouble Ticket Help page 

• Menu Page – describes the Trouble Ticketing: Menu page (see Section 4.2.3.1.16) 

• Submit Page – describes the Trouble Ticket: Submit page (see Section 4.2.3.2.15) 

• Success Page – describes the Trouble Ticket: Success page (see Section 4.2.3.2.16) 

• List Page – describes the Trouble Ticket: List page (see Section 4.2.3.2.17) 

• Detailed Page - describes the Trouble Ticket: Detailed page (see Section 4.2.3.2.18) 

4.2.3.3 Required Operating Environment 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
ReadMe file for each product. To find the ReadMe file for Remedy, use the XRP Baseline 
Manager to determine where in ClearCase the ReadMe file resides. 

4.2.3.3.1 Interfaces and Data Types 

Remedy’s Action Request System exchanges data of various types through interfaces within and 
external to ECS. Table 4.2.3-19 lists Remedy’s Action Request System interfaces for Version 2.0. 

Table 4.2.3-19. External Interface Protocols 
Interface (facility) Type of Primary 

Interface 
Protocols 

Type of Backup 
Interface 
Protocols 

Comments 

Forwarding E-mail Default E-mail Backup 
Interface Protocols 

Site to site forwarding 
of Trouble Tickets 

HTML HTTP Default HTTP Backup 
Interface Protocols 

End user submission 
and queries 

4.2.3.4 Databases 

Remedy’s Action Request System is installed on Sybase; it creates, modifies, and deletes tables as 
schemas are created, modified, and deleted with each column corresponding to a field in the 
schema. This is all done automatically and is invisible to the user. 
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4.2.3.5 Special Constraints 

Note that while Trouble Tickets and the Contact Log schemas are open to all operators, and that 
operators have view privileges to the user schema, only system administrators have the ability to 
modify the schema and tools presented in this section. Privileges are set according to 
DAAC policy. 

4.2.3.6 Outputs 

Output from Remedy’s Action Request System (besides output to the screen in the form of its 
GUIs) is in the form of a report either to the printer or to a file (discussed in Section 4.2.3.8) or a 
log entry as shown in Table 4.2.3-20 below. 

In the Remedy aradmin tool, you may enable / disable logging at any time. Select File-> Server 
Information-> Log Files to display the current location of log files that have been enabled. The 
format of the messages is similar to the Unix syslog as seen in this example: 

Table 4.2.3-20. Remedy Log File Messages Example 

Mon Feb 23 16:28:16 1998 390600 : Failure during SQL operation to the database (ARERR 552)


Mon Feb 23 16:28:16 1998 Unable to connect: SQL Server is unavailable or does not exist. (Sybase 20009) : Connection refused


Mon Feb 23 16:28:16 1998 Unable to connect: SQL Server is unavailable or does not exist. (Sybase 20009) : Connection refused


4.2.3.7 Event and Error Messages 

For Remedy’s Action Request System’s system messages see the Action Request System 
Troubleshooting and Error Messages Guide, Chapter 1 “Trouble Shooting”, page 1-1, and 
Chapter 2 “Error Messages”, page 2-1. 

Table 4.2.3-21 below lists non-system failure related messages which appear on the operator’s 
screen. 
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Table 4.2.3-21. Non-Failure Related Error Messages 
Error Message String Cause Action 

You have to assign the 
trouble ticket to somebody 

Setting the Status to Assigned 
without setting the Assigned-to 
field 

Set Assigned-to field 

You have to assign a Closing 
Code to close 

Setting Status to Closed 
without a Closing Code. 

Set Closing Code field 

You can only submit a Trouble 
Ticket with your login id 

Trying to submit Trouble Ticket 
using someone else’s user ID 

Use your user ID 

Trouble Ticket number 
$Ticket-Id$ has already been 
forwarded to or otherwise 
opened at $Forward-to$ 

Already forwarded Trouble 
Ticket to site in Forward-to field 

Check Forward-to site name against 
the sites that have already been 
forwarded the Trouble Ticket 

Must change status to 
"Forwarded" and fill in the 
"Forward-to" field 

Must set the indicated fields 
before the Trouble Ticket can 
be forwarded 

Check Forward-to and Status fields 
to ensure that they have the 
appropriate values 

There is not an Associated 
Contact Log Id for this 
Trouble Ticket 

Trying to access a Contact Log 
that is not associated with a 
Trouble Ticket through the 
RelB-Trouble Tickets schema 

You can’t access the Contact Log 
for this Trouble Ticket because it 
does not exist 

There has not been a Trouble 
Ticket created for this log 

Trying to access a Trouble 
Ticket that is not associated 
with a Contact Log through the 
RelB-Contact Log schema 

You can’t access the Trouble Ticket 
for this Contact Log because it does 
not exist 

A Trouble Ticket will not be 
created. A Trouble Ticket 
has already been opened for 
this log 

Trying to create a Trouble 
Ticket via the Contact Log that 
has already been created 

You can’t open a Trouble Ticket for 
this Contact Log since one has 
already been opened 

A Trouble Ticket cannot be 
created. Contact Id required 
for Trouble Ticket submission 

Contact ID is required for 
creation of a Trouble Ticket via 
the Contact Log 

Set the Contact ID field 

A Trouble Ticket cannot be 
created without a Log Id 

Trying to create a Trouble 
Ticket via a Contact Log that 
has not yet been saved and 
hence has no Contact ID 

Select Apply to assign a Log ID then 
try and create a Trouble Ticket again 

4.2.3.8 Reports 

The Remedy Action Request System issues the reports described in Table 4.2.3-22 below. 
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Table 4.2.3-22. Reports 
Report Type Report Description When and Why Used 

Ticket Status Report indicates the status of a set of trouble tickets 
based on a particular criteria (e.g., by date 
range, assigned-user, status...) 

When and if someone wants to 
know the status of a set of 
trouble tickets based on a 
particular criteria (e.g., by date 
range, assigned-user, status...) 

Hardware Resource 
Report 

indicates by resource, the number and type of 
problems encountered by the affected 
resource 

When and if someone wants to 
know by resource the number 
and type of problems 
encountered by affected 
resource 

Trouble Ticket User 
Report (Number of 
Tickets by Submitter) 

indicates by submitter, the number and type 
of trouble tickets in the system 

When and if someone wants to 
know by submitter the number 
and type of trouble tickets in 
the system 

Trouble Ticket 
Statistics Report 
(Average Time to 
Close) 

indicates for a particular criteria, statistical 
information such as mean time to close. 

When and if someone wants to 
know for a particular criteria 
statistical information such as 
mean time to close 

Number of Trouble 
Tickets by Status 

provides a summary of the number of tickets 
by status. 

When and if someone wants to 
know a summary of the number 
of tickets by status 

Number of Tickets by 
Assigned Priority 

provides a summary of the number of tickets 
by priority. 

When and if someone wants to 
know a summary of the number 
of tickets by priority 

Trouble Ticket Status 
Report (SMC) 

provides a summary of the tickets by status for 
importing into Excel 

When and if someone wants to 
import a summary of the tickets 
into Excel 

custom reports TTS allows for both extensive customization 
of the above reports and creation of new 
ones. The reporting capabilities include the 
capability to display not only data contained in 
the database but also statistical and 
correlation functions on that data 

When and if someone wants to 
know more than is available 
through the previous reports 

4.2.3.8.1 Sample Reports 

Below are examples of sample reports that can be generated from the Trouble Ticket schema. 
These sample reports include: Ticket Status, Hardware Resource, Number of Tickets by 
Submitter, Average Time to Close, Number of Trouble Tickets by Status, Number of Tickets by 
Assigned Priority, and a Summary Report (imported into Excel). 
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-------------------- 

-------------------- 

-------------------- 

--------------------

--------------------

--------------------

Ticket Status Report 

Ticket Status Ticket-Id 

New TT0000000000148 

TT0000000000139 

TT0000000000142 

TT0000000000146 

TT0000000000144 

TT0000000000147 

Sum = 6 

Ticket Status Ticket-Id 

Assigned TT0000000000149 

Sum = 1 

Ticket Status Ticket-Id 

Closed TT0000000000143 

Sum = 1 

***************************************************************** 

Figure 4.2.3-22. Trouble Ticket Status Report 
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--------------------

Hardware Resource Report 

Hardware Resource 

slimer 

Number of Associated Tickets = 1 

epserver 

Number of Associated Tickets = 4 

cyclops 

Number of Associated Tickets = 3 

********************************************************************* 

Figure 4.2.3-23. Hardware Resource Report 
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-------------------- --------------------

 Number of Tickets by Submitter 

Submitter ID Ticket-Id 

Demo TT0000000000139 

TT0000000000142 

TT0000000000143 

TT0000000000144 

Total Submitted = 4 

Joe Operator TT0000000000148 

TT0000000000149 

Total Submitted = 2 

dmiller TT0000000000146 

TT0000000000147 

Total Submitted = 2 

******************************************************************** 

Figure 4.2.3-24. Number of Tickets by Submitter Report 

Average Time To Close 

Average Time To Close a Trouble Ticket = 0:04:22 

******************************************************************** 

Figure 4.2.3-25. Average Time to Close Report 
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--------------------

--------------------

Number of Trouble Tickets by Status 

Ticket Status 

New 

Number of Tickets = 6 

Assigned 

Number of Tickets = 1 

Closed 

Number of Tickets = 1 

*********************************************************************** 

Number of Tickets by Assigned Priority 

Assigned-Priority 

Low 

Number of Tickets = 8 

************************************************************************ 

Figure 4.2.3-26. Number of Tickets by Assigned Status Report 
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Summary Report to be Imported into Excel (comma separated values) 

"Ticket-Id","Assigned-Priority","Closing Code","Current Site","Hardware Resource","Key 
Words","ProblemType","SoftwareResource","TicketStatus","New.TIME","Assigned.TIME","SolutionPropo 
sed.TIME","ImplementSolution.TIME","SolutionImplemented.TIME","Closed.TIME","Forwarded.TIME"," 
Work Around.TIME","Not Repeatable.TIME" 

"TT0000000000139","Low",,"cyclops","cyclops",,,,"New","05/22/96 11:06:44","", "","","", "","","","" 

"TT0000000000142","Low",,"cyclops","cyclops",,,,"New","05/23/96 10:13:14","","","","", "","","","" 

"TT0000000000143","Low","ConfigurationError","cyclops","cyclops",,,,"Closed","05/28/96 
10:36:27","","","","05/28/96 10:40:49","05/28/96 10:40:54","","","" 

"TT0000000000144","Low",,"cyclops","epserver",,,,"New","05/30/96 09:25:44","","","", "","","","","" 

"TT0000000000146","Low",,"cyclops","epserver",,,,"New","05/30/96 13:47:53","","","", "","","","","" 

"TT0000000000147","Low",,"cyclops","epserver",,,,"New","05/30/96 13:48:18","","","", "","","","","" 

"TT0000000000148","Low",,"cyclops","epserver",,,,"New","05/31/96 11:54:28","","","", "","","","","" 

"TT0000000000149","Low",,"cyclops","slimer",,,,"Assigned","06/07/96 14:04:03","06/07/96 
14:06:17","","","","","","","" 

************************************************************************* 

Figure 4.2.3-27. Summary Report 

4.2.3.8.2 Report Customization


See Remedy’s Action Request System User’s Guide, Chapter 5: “Reports”, page 5-1.
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4.2.4 PEER/Patrol SNMP 

The OptiMaster Master Agent uses Simple Network Management Protocol (SNMP) to 
communicate with Network Management Systems for applications programs. The OptiPro 
enhancements to the application program give the application program sub-agent functionality. 
This makes the application programs remotely manageable. The Application Programming 
Interface (API) and run-time library provide management access to the application program’s 
information structures as it executes. The run-time library consists of code in the PEER 
(Optimaster) Master Agent and the subagent to communicate with code which is compiled into the 
application program. The Master agent communicates with the subagent and system management. 
In turn, the subagent communicates with compiled code in the application program. The 
Encapsulator is provided to communicate with programs that do not have the compiled-in code to 
communicate with the subagent but provide the appropriate MIB interface. This allows all 
application programs to be monitored. 

Operator control of the Master agent and Encapsulator is limited to restarting them as necessary. 

Figure 4.2.4-1. PEER role in ECS systems management data transport. 
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Table 4.2.4-1. Common ECS Operator Functions Performed with 
PEER/Patrol SNMP 

Operating 
Function 

Command/Action Description When and Why to 
Use  

Start Master Agent Peer start command 
See 4.2.4.1.1 below. 

This has to be running on 
each ECS host before 
starting the subagent. 

When necessary to 
restart the Master Agent 

Start Encapsulator Peer start command 
See 4.2.4.1.1 below 

This has to be running on 
each ECS host before 
starting the subagent. 

When necessary to 
restart the Encapsulator 

4.2.4.1 Quick Start Using PEER/Patrol SNMP 

Patrol/SNMP provides a mechanism for the system management of ECS to communicate with 
managed objects. 

Detailed information about PEER/Patrol SNMP may found in these documents: 

Patrol SNMP Toolkit OPTIPro Programmer’s Guide Document 20009


Patrol SNMP Toolkit General Porting Guide Document 20010


Patrol SNMP Toolkit OPTIPro Programmer’s Guide – Advanced Topics Document 20021


Patrol SNMP Toolkit OPTIPro Encapsulator Guide Document 20013


PEER/Patrol SNMP Release 2.3 documentation was used for the references made in this section. 

4.2.4.1.1 Invoke PEER/Patrol SNMP From Command Line Interface 

PEER/Patrol SNMP is normally started during system start-up of an ECS host. The following 
command is used when it is necessary to restart PEER/Patrol SNMP: This command may only be 
executed by an operator with root privilege. 

/usr/ecs/SHARED/CUSTOM/utilities/EcMsAgPeerStart SHARED 

4.2.4.1.2 Invoke PEER/Patrol SNMP From the ECS Desktop. 

Patrol SNMP cannot be invoked from an icon on the ECS Desktop. 

4.2.4.2 PEER/Patrol SNMP Main Screen 

Patrol SNMP does not have a graphical user interface. 
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4.2.4.3 Required Operating Environment 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product. To find the documentation for Patrol SNMP, refer to the ECS 
Baseline Information System web page, URL: 

http://cmdm.east.hitc.com/. 

4.2.4.4 Databases 

None. 

4.2.4.5 Special Constraints 

The PEER Master Agent does not accept non-alphanumeric characters in the configuration 
parameter Community Name. 

4.2.4.6 Outputs 

Patrol SNMP is used to communicate data and data requests between the Network Manager and 
application programs. No data is stored unless a collection is configured on the Network 
Management Platform. 

4.2.4.7 Event and Error Messages 

None. 

4.2.4.8 Reports 

None. 
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